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System Requirements   &   Installation   
  
 
 

System Requirements 
    
To use this software, your PC should have: 
 

A Microprocessor running at  500 MHz ( 1.0 GHz  or faster is recommended ).    
At least 64 MB of RAM ( 128 MB or more is recommended ).  
A graphics display with at least 256 colors. 
Direct X,  Version 4.0  or later ( usually comes with Windows 98 or later ). 
Microsoft Windows 98, Windows ME, Windows XP, Windows Vista.  
A Sound Card or Sound Chip. 
A CD-ROM or DVD drive for installing the software. 

 
 
 
 

Installation 
  
Insert the PitchScope CD into your CD-ROM or DVD drive. The Installation Utility should then start up. Then follow the instructions 
of the simple on-screen Setup Utility. 
 
If on-screen instructions do NOT eventually appear on the screen after inserting the CD, you will have to find a file on the CD named 
"Setup.exe". First launch a My Computer window by double mouse-clicking on the Desktop’s My Computer icon. You can also 
launch a My Computer window by first mouse clicking on the My Computer icon to select it, and then push down on the mouse’s 
RIGHT button, and then select the “Open” command from the popup menu. Once the My Computer window is opened, you can view 
the contents of the CD by double mouse-clicking on the CD or DVD drive’s name. You will then see the file called “Setup.exe” on the 
CD. Double mouse-click on Setup.exe to launch the installation process.  If you have any trouble installing PitchScope, contact 
Customer Service on the Internet at www.CreativeDetectors.com
 
             Known Issues: 
 
Microsoft Vista Only - After installing on Vista, PitchScope's Online Help (F1 on keyboard, or from the Help Menu) may not launch. 
This is because PitchScope uses an earlier version of Microsoft Help (WinHlp32.exe) which was not included in the first version of 
Vista. IF the Online Help files for PitchScope do NOT launch, you can correct the situation by downloading and installing the patch 
for WinHlp32.exe from Microsoft at: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&DisplayLang=en
 
There are 2 types of download files to choose from: Windows6.0-KB917607-x64.msu and Windows6.0-KB917607-x86.msu. Choose 
Windows6.0-KB917607-x64.msu if your computer uses 64-Bit Addressing, and use and Windows6.0-KB917607-x86.msu if your 
computer uses 32-bit Addressing. In future versions of Vista (Service Pack 1 and beyond?) this patch may be included and thus the 
download would be unnecessary. First confirm that PitchScope's Online Help will NOT launch before installing the patch. 
 
 
  
 

Registration 
  
Be sure to register your copy of PitchScope at www.CreativeDetectors.com so that you may receive customer support and 
notifications of future upgrades and bug fixes. 
 
 
 
 

Copyright Notice 
 
Copyright  © 2007 Creative Detectors.  All Rights Reserved.  No part of this documentation may be copied, reproduced, translated 
or transmitted in any form by any means for any purpose without the express written permission of Creative Detectors of San 
Francisco, CA. 
 
The software described in this user's document (PitchScope) is protected by copyright laws and international treaties. Reproduction 
or disassembly of embodied algorithms is prohibited. Unauthorized reproduction of PitchScope, or any portion of, may result in 
severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law. 
 
Microsoft®, Windows®, Windows ME®, Windows XP®, Windows Vista®, and Windows Media Player® are registered trademarks of 
Microsoft Corporation. 

http://www.creativedetectors.com/
http://www.microsoft.com/downloads/details.aspx?FamilyID=6ebcfad9-d3f5-4365-8070-334cd175d4bb&DisplayLang=en
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Introduction 
 
 
PitchScope was originally designed to help musicians figure out and write down the notes in a recording of a musical instrument’s 
solo, such as a solo from a saxophone or an electric guitar. PitchScope is a type of music analysis software that is designed to 
detect the most dominant pitch (i.e. a musical note) at any given moment in time of a MP3 or Wave(.wav) music file. Wave and MP3 
music files can be downloaded from the Internet, or copied from your Audio CDs with the aid of CD Ripping Software or Microsoft 
Windows Media Player. CD Ripping Software is often available for free on the Internet or can be inexpensively purchased. 
PitchScope is designed to work on musical instrument solos, and is not really intended to detect the pitch of a human voice. 
PitchScope can not detect multiple simultaneous notes, but will resort to just finding the loudest pitch at any given moment in time.  
 
Once a Wave or MP3 music file has been loaded into the program, PitchScope can detect the notes and create a Notelist from the 
instrumental solo. After a Notelist is created, it is graphically displayed in a type of Piano Roll format, and its notes can be played 
back at various speeds with Microsoft Windows' internal Midi Software Synthesizer along with the original Wave Recording. Or the 
Notelist can be played alone, and the Wave Recording can be played alone. When playing back at slower speeds the sound does 
not drop in pitch, but remains in the same octave and pitch as when playing at normal play speed. The slowed-down play speeds 
allow the user to gradually learn how to finger the notes on their instrument as they play along. When a Notelist is played back it 
also creates graphic animations that help the user anticipate the upcoming notes while they play along. A Notelist can also be saved 
to a hard drive and later reloaded for user practice sessions, as the user proceeds to master the notes of the solo. 
 
Pitch detection upon polyphonic (multiple instruments playing at once) recordings has long been a major puzzle for audio research 
scientists. While this detection problem has not been fully solved, PitchScope can make accurate note detections in many 
circumstances. However, PitchScope's note detector is not absolute and sometimes makes errors and might miscalculate some 
notes. Since the note detector is not entirely accurate, PitchScope also comes with a Graphic Editor that allows the user to quickly 
correct the initial Notelists that the note detector creates. To help the user find and evaluate errors from the note detector, 
PitchScope also comes with features such as slowed-down play speeds, and various listening options. And of course the corrected 
notelist can be saved to hard drive for later animated playback during future practice sessions. Harmonically dense instruments like 
electric guitars, saxophones, blues harmonicas, clarinets, etc. will detect better with PitchScope than harmonically sparse 
instruments, such as a flute or piano. 
 
PitchScope is a type of educational software and is simple enough for children over 12 years, if an adult or older child will read this 
document and help the child get familiar the program's commands. The software does not require a child to know how to read 
music, or even how to play a musical instrument. As such, PitchScope can be used as a discovery tool that introduces a child to 
some of the building blocks of music -- almost like a microscope with which to observe the notes of an instrumental solo. 
 
 
 
 
 
 

About this Document 
 
Technical terms particular to PitchScope are placed with first letters in capitals (example: Detection Zone), and can be looked up in 
the Glossary Of Terms section at the end of this document.  
 
Definitions in the Glossary Of Terms section of this document are listed in alphabetical order. 
 
Definitions of buttons and other mechanisms in the Windows Diagrams section of this document are also listed in alphabetical order. 
 
Before you go ahead and read all the features, menus, and commands of PitchScope, it might be best to step through Tutorial A 
(see document's section, Tutorials) in order to get a basic feel for the application. But before you proceed with Tutorial A, you might 
also want to first review this document's section named Window Diagrams, and familiarize yourself with the Toolbox and other 
PitchScope windows. During the tutorials you will find these diagrams very useful in identifying the Toolbox's buttons, and other 
window mechanisms. And don't forget, any time you see a technical term whose first letters are in capitals (ex: Detection Zone), you 
might want to read its definition in the Glossary Of Terms section.  
  
This user's guide is organized to deliver information about the use of PitchScope through the use of hands-on tutorials. Rather than 
present the functions of PitchScope through a series of disconnected and abstract definitions, we feel that the easiest way to learn 
this type of software is to take the user step by step through actually situations. For this reason, this Basic Topics and Detection 
Topics sections are short, and are really intended as an overview of the application as a whole. However, the Basic Topics Topics 
and Detection Topics sections do contain references to specific sections of the Tutorials, so that the user may branch off into areas 
of more depth, if they so choose. It is recommended that after first glancing at this document, the user step through each of the five 
tutorials. The tutorials are ordered so that the easiest and most important lessons are presented first, and the more difficult and less 
used techniques are discussed last.  
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Basic Topics  
     
 
 

Microsoft Windows Basics 
  
In order to use PitchScope you will need to know how to do some standard Microsoft Windows maneuvers. This list should gives 
you a brief introduction to the use of the mouse and the Windows operating system. But if you are new to Microsoft Windows or any 
of these topics seem unfamiliar, you may have to go to Windows Help to better learn how to use the mouse and the operating 
system. Also, if you are unfamiliar with how to create a new folder, you might want to look that up in Windows Help. To find 
Window's Help, mouse-click the "Start" button in the lower left of the screen, and choose "Help." 
 

1.  Mouse-Clicking or Clicking -  This means to position the mouse's cursor over an item like a button, and then quickly 
press and release the mouse's left button. If you need to click with the right button, this document will specifically say to click with 
the right button. Sometimes this document will use the phrase "hit the button" which mean "mouse-click on the button".  
  2.  Double Clicking -  This means quickly clicking twice on an item with the left mouse button. 
  3.  Mouse-Dragging -  This refers to the act of pressing down the mouse's left button, dragging the mouse while still 
holding the button down, and finally releasing the button at a specified location.  
  4.  Control Clicking -  This means holding down the keyboard's Control Key ("CTRL") while mouse-clicking with the left 
mouse button. Pressing down the Control Key while clicking alters the behavior of the current mouse tool. 
  5.  Shift Clicking -  This means holding down the keyboard's Shift Key ("Shift") while mouse-clicking with the left mouse 
button. Pressing down the Shift Key while clicking alters the behavior of the current mouse tool. 
 
 
 

Working With Sound Files 
 
As mentioned in this document's Introduction, PitchScope's purpose is to help musicians figure out and remember the notes of 
musical instrument solos. The digital file formats for music that PitchScope can work with are the Wave format and the MPEG 
Layer-3 (MP3) format. The file extension for Wave format is ".wav", and the file extension for MPEG Layer-3 format is ".mp3".  
 
In order to detect the notes in a digital recording, PitchScope must have access to a Wave File in uncompressed stereo Wave(.wav) 
file format at 44.1 kHz with 16 bit samples. That is the same Wave File format that is used to store songs on your Audio CDs. If you 
have CD Ripping Software, you should be able to copy the song files from your Audio CDs to your hard drive in that Wave format. 
CD Ripping Software is inexpensive, and is often found for free on the Internet. However, you may only have access to recordings in 
MP3 format, or a Wave format other than uncompressed stereo Wave(.wav) file format at 44.1 kHz with 16 bit samples. In that case, 
PitchScope also comes with a built-in file converter that can convert most MP3 and Wave files to stereo 44.1 kHz with 16 bit 
samples. If you have Windows XP or later, you probably have a version of Microsoft's Windows Media Player which can also be 
used to extract music files from Audio CDs to your hard drive in the MP3 format (discussed in Tutorial B). (For later versions of 
Media Player, as with Vista, you can also extract directly to the preferred Wave format.) And from that MP3 file, PitchScope's 
internal file converter can create the necessary Wave file in the preferred format. Certain copyright laws may pertain to copying, 
duplicating, or distributing the MP3 and/or Wave(.wav) files that you may extract from Audio CDs. Make sure that you are familiar 
with these laws and their possible implications.  
 
See Wave File, MP3 File, and CD Ripping Software in this document's Glossary of Terms. And also see Tutorial B: Extract a Song 
from an Audio CD, and Convert a MP3 File to Wave Format.   
 
 
 
 

Wave File Navigation 
 
The first step in analyzing the notes of a Wave Recording is to load the Wave File into PitchScope by creating a new transcription 
Project (see Tutorial A, Doing a Simple Note Detection, Step 3 and the Glossary of Term’s definition of Project). Once the Wave file 
is loaded, you will see a graph of its vertical amplitude bars in the Note Detector Window, and will be able to play the Wave with the 
buttons on the Toolbox (see Window's Diagram section, Toolbox sub-section). With the Toolbox, you can navigate to any point in 
the Wave recording, magnify or reduce the window's image of the Wave Recording, and be able to play the Wave at various slowed-
down speeds. Playing the wave at different slowed-down speeds allows the user to more closely hear the instrumental solo, but 
without suffering a change in pitch.  
 
Also on the Toolbox are four magnifying glass buttons (Zoom-Up, Zoom-Down buttons)  that can enlarge or reduce the Wave File's 
graphic image in either the Pitch Viewer or Note Detector Windows. Using the Zoom-Up and Zoom-Down buttons can help the user 
focus on a certain section of the Wave Recording while detecting notes. Those two windows also contain standard Windows Scroll 
Knobs to shift the Wave's image in time to any part of the recording. And at the top of these windows are the Wave's Time Rulers, 
which display the visual image's time position (minutes, seconds, milliseconds) into the recording.  
 
See document's Window Diagrams section, Note Detector Window sub-section and Toolbox sub-section. Also see Tutorial A: Doing 
a Simple Note Detection, step 4: Navigating from the Toolbox Window  for more details 
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Detection Topics  
     
 

Creating Detection Zones 
 
 
About Projects 
 
Within PitchScope, note detection and musical transcription begin by first creating a Project. To create a new transcription Project, 
the user would select the "New Project" command from the File Menu. In creating the new Project the user selects a Wave 
File(.wav) to work on. Once the new Project is created, the Wave File is loaded into PitchScope and is graphically displayed in the 
Note Detector Window as a series of vertical bars that represent the volume of the Wave File at various points in time. 
 
It is within the Project that Detection Zones will be created and stored. A Project is forever linked to the source Wave(.wav) File that 
it was made from. Never try to rename a Project File, and never modify the Wave(.wav) File after a Project has been created.   
For more information about creating Projects, read Tutorial A, step 3 in this document. 
 
 
Why Detection Zones? 
 
As pitch detection can sometimes be slow and consume much memory, it would be very inefficient to detect notes for the entire 
length of a song. For that reason the Detection Zone allows the user to only devote computer resources to the necessary areas of 
instrumental solos within a song file. However, the entire song can still be listened to and practiced with -- only that when the playing 
song enters a Detection Zone, PitchScope will then start to graph the pitch activity and also play the detected notes (the Notelist) 
through the SoftWare Synthesizer. It is within Detection Zones that the user can automatically detect Notes and store them into 
Notelists. A Project and its Detection Zones can spawn any number of Notelist Files, but each Notelist File is forever linked to the 
Project and Detection Zones it came from. And remember, as pitch detection can sometimes be slow and consume much memory, 
never make a Detection Zone for the entire length of a song.  
 
 
Stereo-Mix Channels 
 
Before the user can create a Detection Zone within a Project, he or she must first decide in which Stereo-Mix Channel the 
instrumental solo is the most dominant and loudest. Since we will be detecting notes from a stereo Wave File, we must choose to 
detect from: 
 1)  just the left stereo channel (Display Left Stereo)   
 2)  just the right stereo channel (Display Right Stereo)   
 3)  both the left and right channels combined together (Display Center)  
 
Display Left Stereo, Display Right Stereo, Display Center are menu commands on the View Menu, and allow the user to change the 
visual and audio focus to one of the three Stereo-Mix Channels. After loading the Wave Recording by creating a Project, the user 
must listen to the instrumental solo upon each of the 3 Stereo-Mix Channels and carefully decide which of the 3 channels presents 
the solo instrument the loudest, and with the least interference from other melodic instruments. For most instrument solos, Display 
Center will be the best setting for detection because most solos are typically mixed 'to the center' (between left and right stereo 
microphones). After the user has picked the best Stereo-Mix Channel to use for detection, then he or she is ready to create a new 
Detection Zone.  
 
 
Detection Zone Creation 
 
Now from the Note Detector Window, the user must zoom-down and horizontally scroll the Wave's graphic image, until the entire 
instrument solo can fit inside the window. To do this the user will have to play the Wave Recording while noticing the time positions 
in the Wave's Time Ruler, until they know the time-start and time-finish of the solo. 
 
Next the user chooses the Selection Tool, and then creates a Time-Zone Selection. With the Selection Tool, the user mouse-clicks 
at the start of the solo and then drags the mouse to the end of the solo and releases the depressed mouse button. After the button is 
released, a Time-Zone Selection Box will show an image in reversed gray colors and have two Handles on both of its boundaries. 
The Handles may be mouse-dragged to fine tune the Time-Zone Selection's boundaries.  
 
Then with the Time-Zone Selection Box in view, the user chooses "Create DetectionZone" from the Detection Menu, the calculations 
for the new Detection Zone are started. The calculations may take a while, and a progress bar will show its pace. The new Detection 
Zone box will have a black background. Detection Zones are stored within the Project File, so to save the new Detection Zone the 
Project File must now be saved from the File Menu. 
 
To learn more about creating Detection Zones, step through Tutorial A,  Doing a Simple Note Detection. And also read Project, 
Stereo-Mix Channel, Time-Zone Selection, Wave File. 
 
 
Deleting a Detection Zone 
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The way to delete a Detection Zone to create a new Detection Zone OVER part of an existing Detection Zone. Then the previous 
Detection Zones that were in contact with the new Detection Zone will be deleted from the current Project, and only the new 
Detection Zone will remain. NEVER delete a Detection Zone unless you also want to delete the Notes that it may have created. 
 
 
 

Automatic Note Detection 
 
The end result of PitchScope is to create a list of Notes (i.e. Notelist) that are detected from a musical instrument’s solo. After the 
user has created a transcription Project, and has created a Detection Zone for an instrumental solo, then it is time to apply the note 
detector. 
 
 
Detecting Notes 
 
Within a Detection Zone the user is free to do any number of note detections, and any series of notes may be deleted and 
redetected if desired. Notes can be detected on either the Note Detector Window or the Pitch Viewer Window. The Note Detector 
Window is preferred because the user can test many different settings with the Detect button of the Detect Notes dialog box, as he 
or she fine tunes the dialog's controls for final detection. Notes can ONLY be detected WITHIN Detection Zones. Do not try to detect 
notes outside of a Detection Zone. 
 
To detect notes within a Detection Zone, the Selection Tool is horizontally mouse-dragged to create a Time-Zone Selection Box, or 
the user can use the Select Entire Detection Zone command from the Edit menu. The Time-Zone Selection Box displays as a 
rectangular image in reversed gray colors. The two square handles of the Time-Zone Selection Box can be used to fine tune the 
start and end of the Time-Zone Selection by horizontal mouse-dragging. When the user is satisfied with the location of the Time 
Zone Selection Box, the notes are detected by choosing the “Detect Notes” menu command upon the Detection Menu. 
 
After the Detect Notes menu command is executed, the Detect Notes dialog box is launched and displays two slider controls that 
affect the detection scan: 
 1)  Detection Detail Slider control 
 2)  Weak-Note Cutoff Slider control 
Adjusting these 2 controls can affect how many subtle ‘detail notes’ are found in the solo, and set a cutoff point for weak notes (dark 
gray) that might be noise-notes. The user can hit the Detect button as many times as they like to see the effects of different slider 
control settings -- thus fine tuning the dialog's controls for the best final note detection. Each time that you hit the Detect button, the 
existing notes in the Time-Zone Selection area are deleted, and replaced by a new set of notes determined by the new settings on 
the two slider controls. Step through Tutorial D: Previewing a Note Detection, to see how to toggle these controls while depressing 
the Detect button.     
 
Sliding the Detection Detail Slider control to a maximum value will cause the note detector to respond to the faintest of pitches, so 
much so that a very high setting will pick up 'noise' or irrelevant notes from other instruments. And when the slider is set to a low 
value, some relevant notes might be missed, but noise is at a minimum. Users will want to find the best setting that allows subtle 
notes to be detected, and yet has a minimum number of noise-notes. Similarly, sliding the Weak-Note Cutoff Slider control to a high 
value will cause the note detector to erase many notes with low detection values, indicated by their dark gray color. As the Weak-
Note Cutoff Slider is reduced to a lower value, more dark gray notes will appear. You should experiment with these sliders till the all 
the important notes are found, and noise-notes are at a minimum. 
 
The Detect Notes dialog box also has a checkbox labeled Boost Volume. If the notes all seem to be a dark gray, you could set that 
checkbox in order to increase their Midi volume, and then the detected notes will display lighter shades of gray. Users will want to 
find the best setting that allows notes to be bright enough, and still displays some gray colors for the Notes. If all you see are white 
colored notes, then the Boost Volume checkbox should be unchecked. And if all the Notes have a dark or medium gray color, then 
the checkbox should be checked. 
 
Once a Notelist has been detected, its notes will be graphically displayed in both the Note Detector and the Pitch Viewer windows.  
 
 
The Notelist 
 
The detected Notes of an instrumental solo are grouped together into a Notelist, which can be saved to hard drive as a Notelist File. 
PitchScope uses Microsoft Windows' internal midi SoftWare Synthesizer to generate the notes that you hear when the Notelist 
plays. As the Notelist is being played, the display becomes graphically animated, and a green rectangle will float upon the current 
playing note. And animated notes can also be tracked with a 'bouncing red ball' by setting the Popup Menu's Toggle Frame Advance 
menu command. Playing notes also receive special animation behaviors on the Revolver Animation Window and the Mountain 
Animation Window. 
 
The Notelist and/or the original Wave Recording can be played back at various slowed-down speeds via the Toolbox's Play Speed 
Buttons. The various slowed-down play speeds make it easier for users to play along with the Notelist, and to gradually learn how to 
finger the notes on their musical instruments.   
 
Notes within the Notelist can be edited with standard Copy, Cut, Paste, Delete menu commands. The Notelist can also be saved 
and reloaded from the user's hard drive for later edits or practice sessions. 
 
See Notelist, Note, and SW Synthesizer in this guide's Glossary of Terms, and also step through Tutorial A: Doing a Simple Note 
Detection. Also step through Tutorial D: Previewing a Note Detection. 
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Ways of Listening to Wave Recordings and Notelists 
  
In order to help the user edit and practice with Notelists, PitchScope creates various ways to listen to a Notelist and/or the Wave 
Recording. Since the note detector is not absolute and occasionally makes errors, you will need to make special audio focus when 
evaluating whether or not a note need a correction, like an Octave adjustment. To help you better judge the nature of possible 
detection errors, the following listening modes can help you better focus on a Note's property that might need adjustment. Some 
listening modes pertain to listening to the Notelist as a whole, and some listening modes pertain to listening to just individual notes. 
 
The Notelist and the Wave Recording use two different devices to play aloud. The two devices are:   

1)   Wave Player               (plays the .WAV file that you loaded into the Project) 
2)   Midi SW Synthesizer   (plays the individual notes in the Notelist)  

 
Also see document's Glossary Of Terms' definition for Midi and SW Synthesizer. 
 
 
Listening to the Notelist As A Whole 
 
There are three main ways to listen (called Audition Modes) to the entire Notelist and/or the Wave Recording. The three Audition 
Modes are:   

Midi and Wave   
Just Midi    
Just Wave  
 

The Just Wave mode will only let you hear only the Wave Recording of the song, without hearing the Notelist. This Just Midi mode 
will only let you hear the midi play of the Notelist, but without hearing the Wave recording. And the Midi and Wave mode will let you 
simultaneously hear the Wave Recording along with the Notelist being played by the SW Synthesizer. These modes can be 
switched from the Audition Menu.  
 
Another way to get better focus while playing the Notelist, is to press the Play Window Button instead of the Play Forward Button on 
the Toolbox. When you press the Play Window Button, the playing of the Notelist automatically stops when the last visible note in 
the window is played. Since only the notes in the window are played, the display does NOT scroll forward, but stays focused on the 
current visual segment of the Notelist. The Play Window Button is a convenient way to repetitively hear only a small section of the 
Notelist and/or Wave Recording, without having the window's image advance to a new position in the song. 
 
And yet another way to hear isolated phrases is to use the Loop Play (‘LP’) button on the toolbox. After a Time-Zone Selection is 
made with the mouse, just press the ‘LP’ button on the Toolbox, and the selected time segment will loop over and over until the 
Pause button is pressed.    
 
 
Listening at Various Speeds 
 
The five Play Speed Buttons are located on the bottom of the Toolbox, and affect the play of the Notelist and/or Wave Recording 
after the Play Forward Button on the Toolbox is hit. In order to make the solo easier to study, their purpose is to slow down the play 
speed of the Wave Recording, without altering the original pitch. The buttons are Windows radio buttons and are numerically labeled 
(1,2,3,5,8) with the amount that they can slow down the play of the music. For instance, hitting the radio button labeled "2" will cause 
the notes to play twice as long, hitting the radio button labeled "3" will cause the notes to play three times as long, etc. Being able to 
slow down the play speed of the Wave Recording and/or Notelist can help the user check the accuracy of the note detection, and 
can also help the user gradually learn how to finger the notes on their musical instrument as they play along. 
 
 
Listening To Different Stereo-Mix Channels 
 
As mentioned in the prior Creating Detection Zones section, the user has the choice of creating Detection Zones and detecting 
notes for a Notelist in any of three different Stereo-Mix Channels for any given Notelist. But, while a Notelist and its file may have 
notes from any of the three Stereo-Mix Channels (left, right, center), the visual and audio interface will only show and play the notes 
of only one Stereo-Mix Channel at a time. So if you decide to create Detection Zones inside multiple Stereo-Mix Channels, you must 
remember to set the correct current Stereo-Mix Channel setting from the View Menu so that you see and hear your particular note 
detection of a Detection Zone. The 3 Stereo-Mix Channel settings on the View Menu are:  
 1)  Display Left Stereo - plays and displays just the left stereo channel 
 2)  Display Right Stereo - plays and displays just the right stereo channel  

3)  Display Center - plays and displays both the left and right channels combined together. 
Also read the View Menu section, and Stereo-Mix Channel in the Glossary of Terms. 
 
 
Listening To Individual Notes 
 
For focused listening to individual Notes, PitchScope also gives you some additional utilities. The first is the mouse's Play Note Tool. 
When you mouse-click on an individual Note with the Play Note Tool, you will hear the pitch of that particular note from the SW 
Synthesizer. If you hold down the CTRL key of the keyboard while mouse-clicking, you will hear what the Wave Recording would 
play for the time interval of that note. By clicking with and without the CTRL key, you can verify if the detector has picked the correct 
ScalePitch and Octave for the note, or has made a mistake that needs editing. Read about the Play Note Tool in the Glossary, and 
try it out in Tutorial A, Step 9: Using Some of PitchScope's Mouse Tools. 
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In addition to the Play Note Tool, are the three Step-Play Note Buttons upon the Toolbox (Play Previous Note Button, Play Current 
Note Button, Play Next Note Button). The 3 Step-Play Note Buttons can also be used to audibly test and evaluate an individual note. 
       Here's how they work: 
After first selecting a Note and then mouse-clicking the Toolbox's Play Current Note Button, two successive tones will be heard: 1st) 
the Wave Recording's sound for the time span of the note, and then  2nd)  the actual note being played through the midi SW 
Synthesizer. The audible comparison of the two successive tones can help the user judge if the note is correct, or needs any 
additional editing. By hitting the Play Next Note Button, you can advance the test to the next note, and so on. Read about the Step-
Play Note Buttons in the Glossary, and see how they work in Tutorial A, Step 10: Using The Three Step-Play Note Buttons.  
 
Also see Audition Mode, Play Note Tool, Midi/Wave Balance Slider in this document's Glossary of Terms. Also read the Cleaning Up 
Notelists section, and step through Tutorial A: Doing a Simple Note Detection. 
 
 
 

Cleaning Up Notelists 
 
While PitchScope can make accurate note detections in many circumstances, its note detector is not absolute and occasionally 
makes minor errors, and might even miscalculate some notes. Since the detector is not entirely accurate, PitchScope also comes 
with a Graphic Editor that allows the user to correct the initial Notelists that the pitch detector creates. The Note Detector Window is 
the preferred window with which to edit a note. 
  
A Note in PitchScope can has 3 properties:  
    1)  Duration       (the beginning and end points of a note in time. See Note's Start Handle and Note's End Handle in Glossary)   
    2)  Octave         (within PitchScope, a note can be in one of 4 octaves. See Note's Octave Handle in Glossary)  
    3)  ScalePitch   (a note can have one of 12 ScalePitch values [E,F,F#,G,G#,A,A#,B,C,C#,D,D#].   Also see ScalePitch Channel in 
Glossary. 
 
Using the mouse's Selection Tool, individual Notes may be selected and have their various properties adjusted by mouse-dragging 
the Note's Handles that appear in the Note Detector Window.  
 
PitchScope comes with standard edit menu commands for notes, such as Cut, Copy, Paste, Undo, and Delete. Read Edit Menu 
under this guide's Menu Commands section, and also step through Tutorial C: Editing Some Notes. The user can also manually add 
notes to a Notelist with the use of the Create Note Tool -- but this technique is not for beginners. See Tutorial E: Using the Create 
Note Tool. 
 
 
Spotting Note Detection Errors 
 
The first step in correcting the initial note scan created from the Detect Notes menu command, is to listen to the Notelist play along 
with the original Wave Recording. This is done by setting the Audition Mode to Midi and Wave and pressing the Play Forward Button 
or the Play Window Button upon the Toolbox. The Play Window Button is useful when you only want to focus on a short segment of 
the Notelist without having the display scroll forward to a new location.  
 
You also might want to listen to the Notelist play at a slower speeds by choosing one of the Play Speed Buttons upon the Toolbox. 
Listening with the Audition Mode set to Just Midi is also useful in displaying errors. When you find a Note that sounds suspicious, 
you will want to tighten your focus to a single note with the Play Note Tool or the Play Current Note button. Also read Ways of 
Listening to Wave Recordings and Notelists and step through Using Sound Tests to Find A Bad Note in Tutorial C. 
 
 
Causes of Note Detection Errors 
 
Erroneous notes can occur for a number of reasons. Sometimes if the note detector's Detection Detail Slider is set too high, the 
detector will process 'noise' as notes and possibly pick up some notes from other musical instruments. As you will learn in Tutorial A 
Step 6, note detection with maximum sensitivity (Detection Detail Slider to far right) can cause the note detector to create some 
noise-notes (dark gray notes that are really errors). To clean up some of the 'noise', you will want to listen to the dark gray notes 
with the Play Note Tool (Tutorial A, Step 9) or the Play Current Note Button to determine which notes are complete errors, or which 
notes have problems that can be fixed with an edit. Reread Ways of Listening to Wave Recordings and Notelists to get an idea 
which listening methods best help in the detection of 'noise-notes'. 
 
The most common error that the note detector might make is to pick the wrong Octave, while picking the correct ScalePitch and 
Duration for the note. For this reason, a selected note's Octave Handle makes it very easy to correct the note's octave value while 
maintaining the original ScalePitch value (E, F, F#,G,G#,A,A#,B,C,C#,D,D#). 
 
Excessive 'noise-notes' can also be created if the User has incorrectly picked the wrong Stereo-Mix Channel when creating their 
Detection Zone. Read Stereo-Mix Channels in the Creating Detection Zones section of this document. 
 
Also read: Tutorial C: Editing Some Notes,  Ways of Listening to Wave Recordings and Notelists, and  Tutorial D: Previewing a Note 
Detection, Step 3. 
 
 



Window Diagrams 
 
Definitions of buttons and other controls are listed in alphabetical order. Technical terms particular to PitchScope are placed with 
first letters in capitals (example: Detection Zone), and can be looked up in the Glossary Of Terms section at the end of this 
document.  
 

____________________________________________________ 
Toolbox Window 
 
 

                                        
 
 
The Toolbox Window is the small, non-sizing, window that is seen when the application first starts. It is made up of many buttons 
and controls to help you navigate through Wave and Notelist operations. The names and functions of the Toolbox's buttons are 
summarized below.  
 
 
Align Button (Al) - Use this button when you have both a Note Detector and a Pitch Viewer window open above and below each 
other, and want to vertically find and compare the different visual presentations of the same note or notes. Pressing this button will 
cause the same notes to become vertically aligned, so that it is easier to find the same note in the different windows. All windows 
that are not the active window, will have their horizontal alignment and zoom changed to match the alignment and horizontal zoom 
of the active window. So if you are looking at the Note Detector window and are trying to figure out if a note is valid or not, you can 
press the Align Button and the Pitch Viewer window below will have its notes vertically aligned so that it is easier to examine the 
note's pitch activity upon the Pitch Viewer. It is also a good idea to turn on the Notes' text names when doing this type of 
examination (see Toggle Note Text on the Popup Menu). 
 
Create Note Tool -  PitchScope has three different tools that are associated with the mouse. The Create Note Tool changes the 
shape of the mouse's cursor to that of an i-beam. The Create Note Tool is to only to be used on the Pitch Viewer Windows. Use the 
Create Note Tool to manually detect a note that the automatic note detector might have missed.  
 First, identify the area of the 'undetected note' by looking for its white cluster of pixels in a particular ScalePitch Channel 
on the Pitch Viewer Window. Mouse-click in the white cluster and a new note will be created with a blue outline. You can then go 
back to the Note Detector Window and use the Selection Tool to possibly adjust the note's Octave and Duration with the Handles 
that appear after note selection. To get some experience using the Create Note Tool, step through Tutorial E: Using the Create Note 
Tool. 
  
Detection Zone End Button -  Mouse-clicking on this button to shift the active window's image and current play point to the end 
of the current Detection Zone in view. 
 
Detection Zone Start Button - Mouse-clicking on this button to shift the active window's image and current play point to the 
start of the current Detection Zone in view. 
 
File’s End Button - Mouse-clicking on this button to shift the active window's image and current play point to the end of the Wave 
Recording of the song.   
 
File’s Start Button -  Mouse-clicking on this button to shift the active window's image and current play point to the start of the 
Wave Recording of the song.   
 
Horizontal Zoom-Up Button - Mouse-clicking on this button will cause the currently active window to horizontally magnify the 
section of the Wave and Notelist that is currently visible. 
   
Horizontal Zoom-Down Button - Mouse-clicking this button will cause the currently active window to horizontally compress 
and show a larger section of the Wave and Notelist that is currently visible.  
 
Loop Play Button (LP) - When there is a Time-Zone Selection Box upon the window, mouse-clicking on this button will cause 
the selected time segment to repetitively play over and over. Hit the Pause Button when you want the music to stop. Also see Time-
Zone Selection Box in this document's Glossary of Terms.    
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Midi/Wave Balance Slider -  This control is to be used when the current Audition Mode is set to Midi and Wave (see Audition 
Mode in Glossary of Terms). When in the Midi and Wave mode, you will want to be able to equally hear both the Midi play of the 
Notelist and the original Wave Recording. You can use the Midi/Wave Balance Slider control to increase or decrease the loudness 
of the midi SW Synthesizer (which plays the Notelist) relative to the Wave Recording's loudness. Moving the slider to the right will 
reduce the volume of the Wave recording so that the Midi play of the Notelist will sound louder. Moving the slider control to the left 
will increase the Wave Recording's volume and decrease the volume of the midi SW Synthesizer that plays the Notelist.      
 If moving the Midi/Wave Balance slider can not balance the two music, you may have to open Windows Speaker(Volume) 
Control dialogbox and adjust the values for "SW Synth" and/or "Wave". Make sure that the "Mute" buttons are NOT checked for 
either "SW Synth" or "Wave". The Windows Speaker(Volume) Control dialogbox is opened by double mouse-clicking on the 
Speaker(Volume) Icon in the Windows Taskbar at the far bottom of the screen (for Vista also click on “Mixer” ). Also see Audition 
Mode, SW Synthesizer, Midi and Wave Recording in this document's Glossary of Terms.   
 
Pause Button - Anytime you are playing the Wave Recording and/or the Notelist, you can stop the music at the current point in 
time by hitting this button.   
 
Play Backwards Button - Hit this button if you want to slowly scroll the window’s current view back in time. If you want to make 
a much larger change in time, use the window's Horizontal Scroll Knob.   
 
Play Forward Button -  Hit this button to play the Wave and/or Notelist in the active window. You can stop the music from 
playing by hitting the Pause Button on the Toolbox.   
 
Play Note Tool - When the Play Note Tool has been selected, the mouse cursor changes to the shape of an oval with crosshairs, 
and when mouse-clicked inside a note, only that note will play. You can select the Play Note Tool from the Tools Menu, or you can 
hit the Play Note Tool button on the Toolbox. This tool can be used to check for errors from the note detector, or to slowly study the 
notes in the Notelist. When you hold down the "Ctrl Key" on the keyboard while mouse-clicking, you will instead hear the Wave's 
Recording for the note's time span. By toggling the keyboard's Ctrl Key on and off while mouse-clicking, you can audibly test 
whether or not the note detector has picked the correct Octave and ScalePitch for the note, or whether the note is from another 
musical instrument. If you hold down the keyboard's "Shift Key" while mouse-clicking in the Note Detector Window, you will instead 
hear the Wave's Recording with an unusual filter. For some ears, the Shift Key's filtered Wave sound might be easier to work with 
than the Ctrl Key's unfiltered Wave sound. To get some experience using the Play Note Tool, step through Tutorial C: Editing Some 
Notes.  
 
Play Current Note Button - The Play Current Note Button is one of three Toolbox buttons called the Step-Play Note Buttons 
(see Glossary of Terms' definition for Step-Play Note Buttons). Use this button to test whether or not the note detector has picked 
the correct Octave and ScalePitch for a Note. First select a note with the Selection Tool to establish it as the 'current note'. Then, 
when you hit this button, the current note will play two different tones: 1st) the Wave's sound for the time span of the note, and then  
2nd)  the actual note being played through the midi SW Synthesizer. When the two tones sound the most alike, you have correctly 
set the values for the note. By also mouse-clicking on the Play Previous Note Button and the Play Next Note Button, you can 
incrementally navigate forward and backwards through the entire Notelist as you check for errors from the note detector. Also see 
Step-Play Note Buttons, Play Next Note Button, and Play Previous Note Button. Also read Tutorial C: Editing Some Notes.  
 
Play Next Note Button - The Play Next Note Button is one of three Toolbox buttons called the Step-Play Note Buttons (see 
Glossary of Terms' definition for Step-Play Note Buttons). Use this button to test whether the note detector has picked the correct 
Octave and ScalePitch for a note. First, select a note with the Selection Tool to establish it as the 'current note'. Then, when you hit 
this button, the current note will shift to the next note and you will hear two tones: 1st) the Wave's sound for the time span of the 
note, and then  2nd)  the actual note played through the midi SW Synthesizer. If you want to hear those two tones again, hit the Play 
Current Note Button. When the two tones sound the most alike, you have set the correct values for the note. You can then 
repeatedly step to the next note and hear its two tones by hitting this button again and again, as you progressively check the entire 
Notelist for possible errors from the note detector. Also see Step-Play Note Buttons, Play Current Note Button and Play Previous 
Note Button. Also read Tutorial C: Editing Some Notes.    
 
Play Previous Note Button - The Play Previous Note Button is one of three Toolbox buttons called Step-Play Note Buttons 
(see Glossary of Terms' definition for Step-Play Note Buttons). Use this button to test whether the note detector has picked the 
correct Octave and ScalePitch for a note. First, select a note with the Selection Tool to establish it as the 'current note'. Then, when 
you hit this button, the current note will shift to the previous note and you will hear two tones: 1st) the Wave recording's sound for 
the time span of the note, and then  2nd)  the actual note played through the midi SW Synthesizer. If you want to hear those two 
tones again, hit the Play Current Note Button. When the two tones sound the most alike, you have set the correct values for the 
note. By using the Play Previous Note Button and the Play Next Note button you can incrementally navigate forward and backwards 
throughout the Notelist as you check for possible errors from the note detector. Also see Step-Play Note Buttons, Play Current Note 
Button and Play Next Note Button. Also read Tutorial C: Editing Some Notes.   
 
Play Speed Buttons - The five Play Speed Buttons are located on the bottom of the Toolbox. In order to make a solo easier to 
study, they can slow down the play-speed of the Wave Recording and/or Notelist, without altering the original pitch. The buttons are 
Windows radio buttons and are numerically labeled (1,2,3,5,8) with the amount that they can slow down the play of the music. For 
instance, hitting the radio button labeled "2" will cause the notes to play twice as long, hitting the radio button labeled "3" will cause 
the notes to play three times as long, etc. Being able to slow down the play speed of the Wave Recording and/or Notelist can help 
the user check the accuracy of the note detection, and can also help the user gradually learn how to finger the notes on their 
instrument as they play along. 
 
Play Window Button (PW) - Mouse-click on this button to only play the notes of the Notelist and the portion of the Wave 
Recording, that is visible in the window. The current start note for play will remain the same. The music will automatically stop 
playing when the last note in the window has played. And you can also stop the music at any time by hitting the Pause Button on the 
Toolbox. The Play Window Button is a convenient way to repetitively hear only a small section of the Notelist and/or Wave 
Recording without having the window's image advance to a new position in the song.    



 
Selection Tool Button -  When the Selection Tool has been chosen, the mouse cursor changes to the shape of an arrow. In 
order to edit or modify something, like a Note, you must first select it with this tool. You can choose the Selection Tool from the 
Tools menu, or you can press this Selection Tool button on the Toolbox.  
 
The Selection Tool has many purposes:  

1) Select an individual note for editing  
2) Select multiple notes for editing  
3) Create a Time-Zone Selection  
4) Mouse-dragging a selected note's Handles to edit the note 

    5)     Mouse-dragging a Time-Zone Selection Box's handles in order to change the size of the Time-Zone Selection Box 
 

                                                                       
 
 Mouse-clicking with the Selection Tool inside a note with the mouse's left button will display either one, two, or three 
Handles depending on which window type was used. You can then mouse-drag any of the note's Handles to change the note's 
various properties. Mouse-dragging on the note's center handle will change its Octave, dragging the note's left handle will change 
the note's start in time, and dragging the note's right handle will adjust the note's endpoint in time. A selected note can also respond 
to any of the commands of the Edit menu, such as Cut, Copy, Paste, or Delete.  
 
 If you want to erase the current selection, just mouse-click inside a blank area of the window. 
 
 If you hold down the Ctrl Key on the keyboard while mouse-clicking inside of notes, you can select multiple notes for 
editing. If you hold down the Shift Key while horizontally mouse-dragging, you will select all of the notes inside the time range of the 
drag and release. 
 
 You can also create a Time-Zone Selection with the Selection Tool by horizontally mouse-dragging and then releasing the 
mouse's button. The Time-Zone Selection will display a box of inverted gray colors and have a Handle on either end. Those handles 
may also be mouse-dragged to refine the beginning and end of the Time-Zone Selection Box. Time-Zone Selections are used in 
creating Detection Zones and in doing note detection. To get some experience using the Selection Tool, step Tutorial C: Editing 
Some Notes.  

                                                        
 
 
Vertical Zoom-Up Button - This button is located on the right edge of the Tool Box Window. Mouse-clicking this button will 
cause the currently active window to vertically magnify the section of the Wave and Notelist that is currently visible. When the 
window is vertically zoomed-up, the Vertical Scroll Knob will then activate and allow to the image to be vertically scrolled. If the 
window is NOT vertically magnified, the vertical scroll bar and knob are disabled. 
   
Vertical Zoom-Down Button - This button is located on the right edge of the Tool Box Window. Mouse-clicking this button will 
cause the currently active window to vertically compress and show a larger vertical section of the Wave and Notelist. When the 
window is vertically zoomed-up, the Vertical Scroll Knob will then activate and allow to the image to be vertically scrolled. If the 
window is NOT vertically magnified, the vertical scroll bar and knob are disabled. To bring the window to its lowest vertical 
magnification, keep hitting this button until the image refuses to compress any more. There is no harm in hitting this button to many 
times when trying to reach the lowest level vertical magnification. 
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____________________________________________________ 
Note Detector Window 
 

                                  
                                
 
The Note Detector Window has three main purposes:  First, to enable the user to create Detection Zones and to detect notes, to 
allow the user to edit occasional miscalculations of the note detector (see Cleaning Up Notelists section), and finally to give the user 
animated visual feedback when learning a solo, as they play along with their musical instrument.  
 
Just after creating a new Project you will see the digital WAV recording displayed in the Note Detector Window as a series of gray 
vertical bars that represent the volume of the recording at various points in time. 
 
While PitchScope can make accurate note detections in many circumstances, its note detector is not absolute and occasionally 
makes errors. Sometimes a miscalculation is minor can be fixed by editing the Note. Before a note can be edited, it must first be 
selected with the Selection Tool. A selected note will display Handles that can be mouse-dragged to change one of the note's 
properties (see above diagram).  
 
The graphic animations of the Note Detector Window also become useful as a visual learning-aid as the user practices along with 
the playing Notelist, while he or she gradually learns the solo. Step through this document's Tutorial A: Doing a Simple Note 
Detection in order to learn how to use this window. Also read Tutorial C: Editing Some Notes.  
  
 
Note's Start Handle - A Note can be selected by mouse-clicking with the left button inside a note's rectangle with the Selection 
Tool. The selected note will then display one, two, or three Handles (see above diagram). The handle at the far left is the Note's 
Start Handle, and can be mouse-dragged to change the time value for the start of the note. Most of the time the note detector will do 
a good job of setting this value, but at times you may want to make a minor adjustment. The Note's Start and End Handles will only 
appear if the note is wide enough to fit all of the three handles. If, after selecting the note you only see one handle, go to the Toolbox 
and hit the Horizontal Zoom-Up Button as many times as necessary until the note is finally wide enough to fit the three handles after 
selection.   
 
Note's End Handle - A Note can be selected by mouse-clicking with the left button inside a note's rectangle with the Selection 
Tool. The selected note will then display one, two, or three Handles (see above diagram). The handle at the far right is the Note's 
End Handle, and can be mouse-dragged to change the time value for the end of the note. The Note's Start and End Handles will 
only appear if the note is wide enough to fit all of the three handles. If, after selecting the note you only see one handle, go to the 
Toolbox and hit the Horizontal Zoom-Up Button as many times as necessary until the note is finally wide enough to fit the three 
handles after selection. Note: One way to merge two neighboring notes of the same Fundamental Pitch is to first delete the second 
note, and then drag to the right the first Note's End Handle to the position of the deleted note's endpoint.    
 
Note's Octave Handle - The Octave Handle only appears on Note Detector Windows, and not on Pitch Viewer Windows. The 
handle in the center of the note is the Octave Handle. If you mouse-drag the Octave Handle in a vertical motion, you will change the 
note's octave value while keeping the same ScalePitch value for that note. The most common error of the note detector is to get the 
Octave wrong, while setting the ScalePitch (E, F, F#,G,G#,A,A#,B,C,C#,D,D#) correctly. So to make your cleanup of a note 
detection scan easier, the Octave value can be easily changed with this handle without altering the existing ScalePitch value. As 
you try different octave positions, hit the Toolbox's Play Current Note Button and you will hear two successive tones: 1st) the Wave's 
sound for the time span of the note, and then  2nd)  the actual note played through the midi SW Synthesizer. After testing different 
octave positions, you will be able to judge the correct octave position when the two tones sound the most alike. Double-clicking on a 
note will launch the Note Properties Dialog. Upon it you will see the different strengths for each octave candidate. You can also use 
these octave candidate scores to aid you make a correction. Also see Octave in the Glossary of Terms section of this document. 
Also read Tutorial C: Editing Some Notes, step 4: Correcting A Note's Octave. 
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____________________________________________________ 
Pitch Viewer Window 
 
 

                                
 
 
 
After you have executed the “Create Detection Zone” menu command, the Pitch Viewer window will automatically appear. Upon it 
you will see the differing pitch activity drawn as a white and gray pixels upon the black background of the Detection Zone (see 
diagram above). The whiter the pixels, the stronger the pitch activity in that area of the view. The Pitch Viewer window helps the 
user make decisions when editing notes that the note detector initially creates. 
 
Step through this document's Tutorial A: Doing a Simple Note Detection in order to learn how to use this window. If the Pitch Viewer 
Window is not already displayed, you can open one from the View Menu by selecting "Pitch Viewer".  
 
 
 
Horizontal Scroll Knob - A standard Microsoft Windows control. Mouse-dragging horizontally on the knob will scroll the 
viewable time segment of the Wave recording, forward or backwards in time.  
 
 
ScalePitch Channel - On the Pitch Viewer Window you can see 12 horizontal ScalePitch Channels (see diagram above). A 
ScalePitch Channel has several horizontal rows of pixels that represent the pitch activity for the given channel's ScalePitch value, 
regardless of its octave (example: The F# Channel would show all pitch activity for any notes that are F#, and in any given octave). 
See ScalePitch in the Glossary of Terms section of this document.    
 
 
Wave's Time Ruler - On the top of a Pitch Viewer Window or a Note Detector Window is a Wave's Time Ruler. It looks like a 
horizontal ruler with markings for the time positions into the Wave File for that particular image location. The notation for the time 
markings are given in minutes, seconds, and milliseconds (example:  "2mn 43s 500ms" is 2 minutes, 43 seconds, 500 milliseconds).  
Scrolling the window left or right with the window's Horizontal Scroll Knob will change the time segment of the Wave File that is 
currently in view, and correspondingly change the numeric time values of the Wave's Time Ruler. 
 
 
Vertical Scroll Knob - A standard Microsoft Windows control. Mouse-dragging vertically on the knob will scroll the viewable 
frequency ranges of the notes’ up or down.  
 
Note:  The vertical scroll knob will only work if you have zoomed-up the window in the vertical direction. If the window is at zero 
vertical magnification (stretch mode), then the vertical scroll knob is disabled. When a window initially opens, it is at zero vertical 
magnification (stretch mode).  
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Tutorials 
 
Technical terms particular to PitchScope are placed with first letters in capitals (example: Detection Zone), and can be looked up in 
the Glossary Of Terms section at the end of this document. References to controls and buttons on the Toolbox are also set with first 
letters in capitals, but are defined in the Window Diagrams section, Toolbox Window sub-section of this document.  
 
But before you proceed with the tutorials, you might want to first review the Window Diagrams section and familiarize yourself with 
the Toolbox and other PitchScope windows. During the tutorials you will find these diagrams very useful in identifying the Toolbox 
buttons and other window mechanisms. You might also want to quickly glance, and later study, the Glossary Of Terms section in 
this document to get a rough overview of the application. The tutorials are ordered so that the easiest and most important lessons 
are covered first, and the more difficult and less used techniques are discussed last. Before attempting the tutorials, make sure that 
you have properly installed PitchScope to your computer. 
 
 
 

Tutorial A:   Doing a Simple Note Detection 
 
1.   Launch PitchScope  
Start the PitchScope application by pressing the Windows "Start" button, go to "Programs", and select "PitchScope". Or launch 
PitchScope by mouse double-clicking on PitchScope's Desktop Icon. (If you can still not start the application, use the Microsoft 
Windows Search Function (from Start Button) to find the file named "PScope.exe". When you find the file, double mouse-click on the 
file name to launch). With the application started and no files loaded, you should only see the small Toolbox Window which has no 
title bar. 
 
 
2.   Find a Wave File for Detection   
Launch a My Computer window by double mouse-clicking on the "My Computer" icon of your desktop, or select "Computer" from the 
Start Button’s menu. Use a "My Computer" window to locate the folder named "Examples" inside the “Program Files” folder’s 
PitchScope folder (Program Files\PitchScope\Examples\ ). Inside of the Examples folder you should find a file called 
"Ps_Solo_1.wav If you can not find the Examples folder, use the Windows Search function to find the file called "Ps_Solo_1.wav". 
The Windows Search function is launched by hitting the "Start" button, selecting "Search", and then "For Files and Folders..."   
 
 
3.   Create a New Project   
In PitchScope's File Menu, select "New Project". Within the "Create New Project" dialog box, mouse-click on the upper Browse 
button(Pick Wave or MP3 Music File). Then use the Open Wave or MP3  file dialog box to navigate and select "Ps_Solo_1.wav" in 
the Examples folder, and then hit the "Open" button. In the "Project's Name" text box fill in a name for the project file, namely 
"Ps_Project_1”. Then mouse-click on the lower Browse button (Pick Project File’s Location), and use the Select Folder file dialog 
box to navigate to the folder named "Examples". With the name of the project file (Ps_Project_1) in the File Name text box, hit the 
Open button to assign the path for the new Project's file. Carefully inspect the choices you made in the Create New Project dialog 
box for Music File's Path and Project Name, and Project File's Path. If you are satisfied, hit the “Create” button. But if any of the 
information looks wrong, merely hit the “Cancel” button and repeat this step from the beginning. After hitting the "Create" button, you 
should see a confirmation dialog, then hit "OK", and the Note Detector Window should open with a graph of the Wave file's 
amplitudes as vertical bars. 
 

                                               
 
4.   Navigating from the Toolbox Window   
Now that the Wave File(.wav) has been loaded and a new Project File has been created, you can play the Wave Recording forward, 
backwards, and at various slower speeds. We will now use the Toolbox to play the Wave. To locate any of the named Toolbox 
buttons, look at the diagram above. To play the Wave, go to the Toolbox Window and mouse-click the Play Forward Button. If you 
want to stop the music from playing, hit the Pause Button. To jump to the end of the Wave Recording, hit the File’s End Button. To 
go back to the start of the Wave Recording, hit the File’s Start Button. At any time while the music is playing you can hit any one of 
the Play Speed Buttons (circular Radio Buttons with the numerals: “1,2,3,5,8”) to slow down the song. Hitting the Play Speed Button 
called “2” will cause the music to play at 1/2 the normal speed while keeping the notes at the same pitch. Similarly, hitting the Play 
Speed Button called “3” will cause the music to play at 1/3 the normal speed, hitting the Play Speed Button called “5” will cause the 
music to play at 1/5 the normal speed... etc. Take a few minutes to play the Wave Recording while experimenting with these 
Toolbox buttons. 
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When playing and detecting music, you must choose which of 3 Stereo-Mix Channels to detect notes from.  
The three Stereo-Mix Channels are:  
    1)   Left Stereo-Mix channel      (hear only left stereo),  
    2)   Right Stereo-Mix channel    (hear only right stereo) 
    3)   Center Stereo-Mix channel  (hear both left and right stereo channels combined).  
 
You will have the best results at note detection by selecting the Stereo-Mix Channel that plays the instrumental solo the loudest, and 
with the least interference from other tonal instruments. To change the current Stereo-Mix channel setting, go to the View Menu and 
select either Display Center, Display Left Stereo, or Display Right Stereo. For most recordings a musical instrument solo will be 
mixed in the 'center' of left and right stereo speakers, so selecting Display Center will typically work best. For this tutorial, make sure 
that Display Center is selected and checked on its menu item.  
 
Also on the Toolbox window are four buttons that magnify the image in the currently active window. The two Horizontal Zoom 
Buttons can horizontally either magnify or shrink the time interval of the Wave File that is displayed in a window. Take a few minutes 
to experiment with the two Horizontal Zoom buttons. The two Vertical Zoom Buttons are rarely used and can sometimes confuse the 
new user. For now, just leave the two Vertical Zoom buttons alone. 
 
You might also want to take a few more minutes to familiarize yourself with the various Toolbox buttons by playing the Wave and 
observing the various effects of the different buttons. Also read the definitions for the different Toolbox buttons in this document's 
Window Diagrams section, Toolbox Window sub-section.  
 

                                                           
 
5.   Create a New Detection Zone  
On the View Menu make sure that Display Center is selected and shows a checkmark by “Display Center”. Then hit the Toolbox's 
File’s Start Button to make sure that the window shows the very beginning of the Wave Recording. Now we must horizontally shrink 
the Wave so that it is entirely visible within the Note Detector Window’s horizontal direction. To do this, hit the Toolbox’s Horizontal 
Zoom-Down Button (small magnifying glass on lower right) a few times until the end of the Wave File comes into view. The end of 
the Wave is where there are no more vertical bars on the right and only light gray is seen.  
 
Go to the Tools Menu and make sure that the Selection Tool is chosen (should see a checkmark by the word “Select”). With the 
Selection Tool, push the left mouse button down at the left of the window, drag the mouse (button still down) till the mouse's arrow 
cursor is near the far right of the vertical bars, and then release the mouse button. The Time-Zone Select Box should now be visible. 
The Time-Zone Select Box will show an image in reversed gray colors and has two handles (small squares) that allow fine tuning 
the start and end of the Time-Zone selection by mouse-dragging. If you are not happy with the position of the Time-Zone Select 
Box, you can mouse-click once inside the window, it will go away, and then you can try again. When you are satisfied with the 
position of the Time-Zone Select Box, go to the Detection Menu and select “Create DetectionZone”. The calculations for the new 
Detection Zone may take a while, and a Progress Bar will show you how quickly they are proceeding. At the end of calculations you 
will see a confirmation box, hit its “OK” button, and notice that the new Detection Zone box has a black background. Keep the 
horizontal magnification of the window at its current setting. Now save the new Detection Zone to the Project File by going to the File 
Menu and selecting “Save Project”. 
     Note: As pitch detection can sometimes be slow and consume much memory, never make a Detection Zone for the entire length 
of a song. Only create Detection Zones where you really need them, like in a musical instrumental solo. 
  
 
6.   Detect Some Notes   
You can detect notes on either the Note Detector Window or the Pitch Viewer Window. The Note Detector Window is preferred 
because the user can test many different setting with the Detect button on the Detect Notes dialog box, as he or she fine tunes the 
dialog's controls for final detection. Now activate the Note Detector Window by mouse-clicking inside the window. If a Note Detector 
Window is not displayed, you can launch a new one from the View Menu by selecting "Note Detector."  
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Next you must make a selection inside the Detection Zone to determine where the notes are to come from. If you want to select the 
entire Detection Zone, use the “Select Entire Detection Zone” command on the Edit Menu. If you only want to select a portion of the 
Detection Zone, you must mouse-drag with the Selection Tool as follows: with the Selection Tool, push the left mouse button down 
at the left start of the Detection Zone, drag the mouse to the right edge of the Detection Zone, and then release the mouse button. 
Again you should see the Time-Zone Selection Box as an image in reversed gray colors. The two small square handles of the 
Selection Box can be used to fine tune the start and end of the Time-Zone selection by mouse-dragging. It is not necessary to 
precisely set the boundaries of the Time-Zone Select Box to exactly the same boundaries as the Detection Zone. In fact, they can 



even go outside of the Detection Zone's boundaries. If you have used the “Select Entire Detection Zone” command, then there will 
be no handles on the Time-Zone Selection Box to adjust. 
Now, with the Time-Zone Select Box visible, go to the Detection Menu and select “Detect Notes”. This will launch the Detect Notes 
dialog box. For this tutorial, just leave the existing settings on the dialog's Detection Detail slider control and Weak-Note Cutoff slider 
control (Detection Detail at "89", and Weak-Note Cutoff at "49"). Now just mouse-click on the “Detect” button. When the detection of 
notes is complete you should see the notes draw as gray solid rectangles if the Note Detector Window is used, and the notes will be 
drawn in hollow blue rectangles if performed on the Pitch Viewer Window.  
 

                                                  
 
Notice that the Detect Notes dialog box also has a checkbox labeled Boost Volume. If the notes all seem to be a dark gray, you 
could set that checkbox to increase their Midi volume, and then have the notes display lighter shades of gray. Users will want to find 
the best setting that allows notes to be bright enough, and yet still displays some varying gray in the colors of the Notes. If all you 
see are white colored notes, then the setting for the Boost Volume checkbox should become unchecked. And if all the Notes have a 
dark or medium gray color, then the Boost Volume checkbox should become checked. 
 
You can repetitively press the Detect button while testing different settings on the two slider controls. Once the Detect Notes dialog 
box is launched, PitchScope remembers the Time Zone Selection after successive Detect Button presses -- you do not have to use 
the mouse to later make Time-Zone Selections. And each time that you hit the Detect button, the existing notes in the time selection 
area are deleted, and replaced by a new set of notes determined by the new settings on the two slider controls. If you want to hear 
what your new notes sound like just hit the "Play Notes" button, and then hit the "Stop Play" button to stop the music. When you are 
satisfied with the note detection scan, press the "Save" button to close the dialog box. And if you are unhappy with the scan press 
the "Cancel" button, and then the notes that were in the Notelist before the launch of the dialog will return. Always close the Detect 
Notes dialog box immediately after you are done with the detection scan. 
 
It is now time to expand the horizontal image on the Pitch Viewer Window in order to see the detail of the Notes. First activate a 
Pitch Viewer Window by mouse-clicking inside the window. If one is not visible, go to the View Menu and launch one by selecting 
"Pitch Viewer". Then go to the Toolbox and hit the Horizontal Zoom-Up Button a couple of times till you can see the insides of the 
notes. Scroll the window to the right with the Horizontal Scroll Knob, and notice how the Detection Zone on a Pitch Viewer Window 
will display the pitch activity inside the notes with clusters of light gray and white pixels.  
 
Now re-activate the Note Detector Window. While the Pitch Viewer Window will only vertically display the notes in the twelve 
ScalePitch values (E,F,F#,G,G#,A,A#,B,C,C#,D,D#), the Note Detector Window will vertically display notes by their Fundamental 
Pitch values (with octave values) graphically in a Piano Roll format. To have the notes in a window display their letter names, push 
down the right mouse button inside the window and a popup menu will appear. Select “Toggle Note Text” to either show or hide the 
notes’ letter names (also see document's Menu Commands section, Popup Menu sub-section). 
 
While both the Note Detector Window and the Pitch Viewer Window can be vertically zoomed-up (magnified) to reveal more vertical 
detail, vertical magnification can sometimes confuse the new user. So for that reason, leave the Vertical Zoom-Up buttons alone and 
at their lowest magnification. When you launch a new window, it is automatically set to its lowest vertical magnification.  
 
For more information, also see Detection Detail Slider and Weak-Note Cutoff Slider in this document's Glossary of Terms. And later 
you can step through Tutorial D, Previewing a Note Detection, to learn how to adjust the Detection Detail and the Weak-Note Cutoff 
slider controls for more accurate note detection.     
  
 
7.   Save the New Notelist  
Now that you have detected a new Notelist, you will want to save it to your hard drive so that you may later hear or modify it. Go to 
the File Menu and select “Save Notelist”. This will launch the Save As file dialog box. You can use its standard Microsoft Windows 
commands to navigate to a special folder, or to create a new folder if you like. For now, just navigate to the Examples folder, and 
write “Notelist_1” in the File Name text box. Hit the “Save” button, and the new Notelist file will be saved to that folder.  
  
 
8.   Playing the Wave and Notelist In Different Audition Modes  
Now that you have created a new Notelist, you will want to hear it play -- sometimes along with the Wave Recording, and sometimes 
by itself. The Notelist and the Wave Recording use two different devices to play. The two devices are:   
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1) the Wave Player                        (plays the .WAV file that you loaded) 



2) the Midi SoftWare Synthesizer  (plays the individual notes in the Notelist)  
 
There are three ways to listen (called Audition Modes) to the Notelist and/or the Wave Recording. The three Audition Modes are:   

1) Midi and Wave   
2) Just Midi   
3) Just Wave  

 
The Just Wave mode will only let you hear the Wave Recording of the song, without hearing the Notelist being played. Now go to 
the Audition Menu and select "Just Wave." Go to the Toolbox and first hit the File's Start Button, and then the Play Forward Button. 
Though you can see the Notelist's current note being animated with a green rectangle, you can NOT hear the Notelist being played. 
 
Now hit the Pause Button to stop playing the music, and go to the Audition Menu and select "Just Midi." Again go to the Toolbox and 
hit the File's Start Button, and then hit the Play Forward Button. This time you can hear the Notelist being played by the midi SW 
Synthesizer, but you can NOT hear the original Wave Recording being played.   
 
And now hit the Pause Button to stop play, and go to the Audition Menu and select "Midi and Wave."  Now go to the Toolbox and hit 
the File's Start Button, and then hit the Play Forward Button. You should now be simultaneously hearing both the Notelist and the 
Wave Recording. When in the Midi and Wave audition mode, you can use the Toolbox's Midi/Wave Balance Slider control to 
increase or decrease the loudness of the Notelist' sound relative to the Wave Recording's sound. Moving the slider to the right will 
reduce the volume of the Wave Recording, so that the Notelist will appear louder by comparison. Moving the slider to the left will 
increase the volume of the Wave Recording and drown out the Notelist. Take a few minutes to experiment with the Midi/Wave 
Balance Slider control while in the Midi and Wave audition mode. Ideally you should balance the two sound sources so that you can 
distinctly hear each one of them. Always stop play with the Pause Button before executing a menu command. Also when starting a 
new Project, it is probably best to leave the Midi/Wave Balance Slider control in a the 'middle position', and later fine tune its setting 
after you have created a Notelist. Also see Midi/Wave Balance Slider, SW Synthesizer, Midi, and Audition Mode in this document's 
Glossary of Terms.   
 
When simultaneously listening to the Notelist and the WAV recording (from the Midi and WAV audition mode), it is necessary to 
have the two musical sources be synchronized in time. Because different microprocessors and sound hardware sometimes execute 
midi play commands with different response times, PitchScope must sometimes have its Timing-Advance Factor altered to fine tune 
the synchronization of play. If the play of the midi notes sounds a little out of beat with the play of the source WAV file, you can then 
you can correct the problem by adjusting the Timing-Advance Factor on the Options dialog. You can open the Options dialog from 
the Tools Menu by selecting "Options..."  To learn how to set the Timing-Advance Factor, read about it in the Options Dialog part of 
the Tools Menu section in this document. 
 

                                                                          
  
9.   Using Some of PitchScope's Mouse Tools  
On the Tools menu, you will see choices for the three mouse tools:  1) Selection (tool),   2) Play Note (tool),  and the  3) Create Note 
(tool). The different tools can also be selected on the Toolbox. The three large buttons at the far left of the Toolbox represent the 
three different tools. As shown earlier in this tutorial, the Selection Tool can be use to make a Time-Zone Selection to create a 
Detection Zone, or to create a Time-Zone Selection for multiple note selection. The Selection Tool can also be used to individually 
select notes for editing (cut, copy, paste, and delete). If the note detector is too sensitive (see Detection Detail Slider), it will pick 
some irrelevant pitches from other instruments. To delete a note, first mouse-click with the Selection Tool on a note and notice that 
when a note is selected, some Handles will appear on the note. Use the Edit menu's Cut command to remove the note after it has 
been selected. If you change you mind about the edit, merely select Undo from the Edit menu. To select multiple notes, hold down 
the keyboard's CTRL key while mouse-clicking with the left button.  
 
Now let's try the Play Note Tool. Go to the Tools menu and select "Play Note". Notice how the mouse's cursor changes shape to an 
oval with two cross hairs (the same icon as on the Toolbox's far left button which can also select the Play Note Tool). When you 
mouse-click on an individual note with this tool, you will hear the pitch of that particular note being played through the SW 
Synthesizer. If you hold down the keyboard's CTRL key while mouse-clicking, you will hear what the Wave Recording would play for 
the time interval of that note. By clicking with and without the CTRL key while listening, you can verify if the detector has picked the 
right pitch and octave for a valid note, or has maybe generated an irrelevant note from another instrument. Use the Play Note Tool 
in this manner to search for note detector errors to be later edited or deleted. Also see Selection Tool and Play Note Tool in the 
"Tools Menu" sub-section of the Menu Commands section of this document, and Selection Tool and Play Note Tool in the Glossary 
of Terms section of this document.   
  
 
10.   Using the Three Step-Play Buttons     
As mentioned, you might have to spend a little time 'cleaning up' a newly detected Notelist, and delete some of the irrelevant notes 
(noise) from the note detection. A useful mechanism for note cleanup are the three Step-Play Note Buttons. The three Step-Play 
Note Buttons (Play Previous Note Button, Play Current Note Button, Play Next Note Button) are located on the Toolbox (see 
document's Window Diagrams section, Toolbox Window sub-section). Use these buttons to audibly test whether or not the note 
detector has picked the correct Octave and/or ScalePitch for a note.  
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Here is how the three buttons work. First select a note with the Selection Tool to establish it as the current note. Then hit the Play 
Current Note Button, and the current note will play two successive tones: 1st) the Wave's Recording's sound for the time span of the 
note, and then  2nd)  the actual note played through the midi SW Synthesizer. If you want to hear those two tones again, just hit the 
Play Current Note Button a second time. You can then move to the next note for the same tone test by hitting the Play Next Note 
Button. By repetitively hitting the Play Next Note Button, you can incrementally step through all the notes in the Notelist while 
checking and correcting errors. If you want to navigate to an earlier note, just hit the Play Previous Note Button. Also see definitions 
for Play Previous Note Button,  Play Current Note Button,  and Play Next Note Button in this document's Window Diagrams section, 
Toolbox Window sub-section. Take a few minutes to try out and become familiar with these three buttons -- they can be very useful 
for notelist corrections. 
 
 
11.   And Lastly    
This concludes the Tutorial A. Remember that to save your changes, you might have to save one or both of PitchScope's two file 
types:  
     a)  The Project File (.ppj) saves the Detection Zones that you might create or change. A Project File is always linked to the Wave 
File of its creation. Never modify a Wave file (.wav.) after you have created a Project File for it. The Project File is the 'parent' file of 
which many Notelist Files may be later created.  
     b)  The Notelist File (.pnl) saves the notes that you detect or create. A Notelist file always refers back to the Project File that was 
used for its creation. While a Project File may have many Notelist files that refer to it, a Notelist File can have only one Project file as 
its 'parent'. Never try to rename a Project File or it will confuse its 'child' Notelist Files. In order to edit a Notelist file you should make 
sure that its Project File is also loaded.   
 
 
  

Tutorial B:    Extract a Song from an Audio CD,   
                     And Convert a MP3 File to Wave Format 
   
As previously mentioned, you will need music files in either the Wave(.wav) or MP3(.mp3) format in order to detect notes with 
PitchScope. Though Wave and MP3 music files can be found on the Internet or in your friend's collections, you will probably want to 
copy some music files from your Audio CDs. If you have good Wave Editor software, that may be able to extract('rip') or copy the 
.WAV files from your audio CD. CD Ripping Software is often available for free on the Internet, or can be inexpensively purchased.  
 
If possible, copy or 'rip' your song files to an uncompressed Stereo Wave(.wav) file format at 44.1 kHz with 16 bit samples, because 
this is the final format that you will need to do note detection in a PitchScope Project. If you cannot get the music files in that format, 
you still may be able to use other Wave(.wav) formats and the MP3 format, but PitchScope will have to convert them into a Stereo 
Wave(.wav) file at 44.1 kHz with 16 bit samples. If a file conversion is to be performed there may be a small loss in sound quality, 
but pitch detection can still proceed. If a file conversion has been performed, only the final converted version(.wav) of the file is then 
needed.  
 
If you have Windows XP or a later version of Windows, then you automatically have a version of Microsoft's Windows Media Player 
which can also be used to copy music files from your Audio CDs to the MP3 format. This tutorial will step you through to act of 
copying music files from CDs with Windows Media Player. If you have any trouble understanding this tutorial, remember that 
you can always read Windows Media Player's own help topics for answers. To see Media Player's help topics, go to its "Help" 
menu and select "Help Topics" from the sub-menu. 
 
 
1.  Launch Windows Media Player 
Go to the Windows "Start" button at the bottom left of the display, first select "Programs", and then select "Windows Media Player" 
from the menu.  
 
 
2.   Insert an Audio CD Into the Computer 
Audio CDs are the kind of music CDs that you might play in your stereo. Load an Audio CD into the computer's CD-ROM drive or 
DVD drive. If after you insert the CD you get a message box called "Audio CD" and asks if you want to "Play Audio CD...", just hit 
the Cancel button to close the message box.  
 
 
3.   Set the File Preferences for Windows Media Player  
Go to Windows Media Player's Tools Menu and select "Options..." This will launch the Options dialog. Click on the "Copy Music" 
tab. From the "Copy to music location" box, write down the setting for its path (example: C:\WinMediaMusic). This will be the folder 
where the copied music files will be placed. Then go to the "Copy settings" box, and in the "File format" drop-down box select 
"MPEG Layer-3" (i.e. MP3 format). Do NOT select "Windows Media Audio", because PitchScope can NOT convert from that file 
format. If you can make a "Best Quality" setting on the slider control choose it, but at present Windows Media Player does not allow 
a "Best Quality" setting on the slider for "MPEG Layer-3". Later versions of Media Player (in Vista) will let you extract directly to the 
Wave (.wav) format. If this is possible, select a Wave format for an uncompressed stereo .WAV file at 44100 Hz with 16 bit samples.  
Hit the "OK" button to save your settings and close the Options dialog box.  
 
 
4.   Execute the Copy Command 
Go to Windows Media Player's "File" Menu and first select "Copy", and then select "Copy From Audio CD" from the sub-menu. A 
dark screen will come up and list all the Tracks (songs) on the Audio CD. Uncheck all the Tracks that you do NOT want to copy to 
your hard drive, so that only the ones that you want have a checkmark next to them.  
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Next you will want to rename the 'Titles' of each track. To change a Track's Title, first mouse-click in the row to select that song and 
row. After the row is selected, click once in the row's Title field (example: "Track 01"). When you see a white rectangle in the Title 
field, then type in a unique name for the song (example: psSong1).  Repeat this for each track that you have a checkmarked.  
 
After you have given all the tracks that you want to extract a unique file name, look in the upper right of the screen for a button that 
says "Copy Music". Mouse-click that that "Copy Music" button. If you get a dialog that asks if you want to change your target file 
type from MPEG Layer-3(MP3), select "No" and to keep the MP3 setting that you just made in Step 3 (however if you can extract in 
a WAV format, use that). And if you get another dialog box that asks if you want 'copy protection', select for "NO Copy Protection". 
While the Media Player is copying the music, you will see its progress being written in the "Copy Status" field for each Track as it 
does its job.  
 
When each of the checkmarked rows shows "Copied To Library" in the Copy Status field, you are done copying songs. But before 
you exit Windows Media Player, look into the drop-down text box at the upper right hand corner of the screen. Write down the Folder 
Name that it displays (example: "Unknown Album 2/16/07"). Your newly created MP3 music files will be located in that folder, which 
is itself located in the "Copy to music location" folder that you just wrote down in Step 3. Also write down the new names that you 
gave the songs (ex: psSong1).   
 
 
5.   Find and Copy the new Music Files 
Double mouse-click on the "My Computer" icon on your desktop, or select “Computer” upon the menu from the Start Button. This 
launches a window from which you can navigate upon your hard drive. In the My Computer window, mouse click on the "Folders" 
button, and then double-click on "Local Disc(C:\)" in the file tree. This shows the folders on your hard drive in a 'tree hierarchy', and 
should make it easy to create new folders and to navigate to files. If you have any trouble using this window to navigate to your files, 
remember that you can always go to Microsoft's "Help" menu for more information. 
 
Now create a new folder for a PitchScope Project, and name it "psFolder1". To create a new folder from this window, go to the "File" 
Menu and select "New", and then "Folder" from the sub-menu. Where you see the hilighted text saying "New Folder", type in 
"psFolder1". 
 
Next navigate down the path that you wrote down in Step 3 (might be C:\WinMediaMusic), and then navigate to the sub-folder that 
you wrote down in Step 4 (example: "Unknown Album 2/16/07"). You might have to first open the "Unknown Artist" folder before you 
can find this sub-folder. Then, within that folder, you should see the song file that you just extracted (example: "01 psSong1.mp3"). 
Notice that Windows Media Player will prepend the CD's track number to your new song's name (example: Track 1 will prepend 
"01", Track 2 will prepend "02", etc). 
 
Remember that if you have trouble finding your .MP3 song in the file tree window, you could also use the Window's "Search" 
function to find the file. To use Window's Search Function, mouse-click on the "Start" button at the bottom left of the screen and 
select "For Files or Folders..." Then in the "Search Results" window, click "All files and Folders" on the left, and then write the name 
of your song file in the "All or part of the file name" text input box (ex: "psSong1"). Then hit the "Search" button, and wait for the 
results. After you have found your newly extracted .MP3 song file, copy it to your newly created folder named "psFolder1".   
 
 
6.   Create a New Project and Do A File Conversion 
Now we will create a new PitchScope transcription Project, and also demonstrate how PitchScope can convert psSong1.mp3 into a 
.WAV file that we can use for note detection. First launch PitchScope (see Tutorial A). 
 
From PitchScope's File Menu, select "New Project". Upon the "Create New Project" dialog box, mouse-click on the upper Browse 
button(Pick Wave or MP3 Music File). Then use the Open Wave or MP3 File dialog box to navigate to the psFolder1 folder, select 
"psSong1.mp3" to the File Name text box, and then hit the "Open" button. 
A message box will open that says: "This file is not a stereo .WAV file at 44100 Hz with 16 bit samples. A new file will now be 
created to that format." Hit the OK button and a Progress Bar will show the ongoing status of the calculations. If the conversion goes 
correctly, you should see another message box that says: "A compatible .WAV file[ psSong1.wav ] has been successfully created, 
and may be used for the new project." Hit the OK button and you will return to the partially completed "New Project" dialog box. 
 
In the dialog's "Project's Name" text box, fill in the name for the Project file, namely "psProject1”. Then mouse-click on the lower 
Browse button (Pick Project File’s Location), and use the Select Folder file dialog box to navigate to the new folder named 
"psFolder1". With the name of the Project File (psProject1) in the File Name text box, hit the Open button to assign the path for the 
new Project File. Notice that you do not have to include the file's extension (".ppj") in the File Name text box. Then hit the “Create” 
button to create the new Project and its associated Project File (psProject1.ppj).  
 
If you examine the contents of psFolder1, you will see that along with the Project File (psProject1.ppj) you will also see a new music 
file named psSong1.WAV (not to be confused with psSong1.MP3). At this point the .MP3 file is no longer needed, and you only 
need to include psSong1.wav with the psProject1.ppj to run the Project. Do NOT edit or change the name of the .WAV file, and 
NEVER re-name a Project File (psProject1.ppj).   
   
 
7.   File Conversion Through the "Load Wave/MP3" Menu Command 
Suppose you wanted to just load a music file into PitchScope so you could initially hear it, and then decide if you would like to later 
use it for a transcription Project. For that purpose you could use the "Load Wave/MP3" menu command on PitchScope's "File" 
Menu.  
 
So, if you then executed the "Load Wave/MP3" menu command, you would see the Open file dialog box. You would then navigate 
to a new music file, say "psSong2.mp3", and select that name to the File Name text box. If it was a MP3 file, or a Wave(.wav) file 
other than at stereo 44.1 kHz with 16 bit samples, after hitting the Open button you would again see the same message box of Step 
6 that says: "This file is not a stereo .WAV file at 44100 Hz with 16 bit samples. A new file will now be created to that format".  
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After hitting the "OK" button, a new Wave file named "psSong2.wav" will be created in the same folder with psSong2.mp3, and then 
loaded into PitchScope. Later, if you decide that you would like to make a transcription Project for that song, make sure that you use 
the file named psSong2.WAV (NOT psSong2.MP3) in the Create New Project dialog box. 
 
 
 

Tutorial C:   Editing Some Notes   
 
While PitchScope can make accurate note detections under many circumstances, PitchScope's note detector is not absolute and 
occasionally makes minor errors, and might miscalculate some notes. Since the detector is not entirely accurate, PitchScope also 
comes with a Graphic Editor that allows the user to correct the initial notelists that the pitch detector creates. You will want to do ALL 
of your note edits on the Note Detector Window where a note's shade of gray can give you an idea of the certainty for the detection 
accuracy for that note. Dark gray notes suggest that the note detection might NOT have much certainty, and very light gray notes 
suggest that a note is likely to be an accurate detection. To better view the detection values for an individual note, mouse double-
click upon a note, and the Note Properties dialogbox will appear. It will contain the note’s detection score, and the scores for the four 
different octave candidates. Also, when you get a chance, read the Cleaning Up Notelists section of this document. 
 
This tutorial will introduce you to some of the edit tools and techniques that you can use to clean up some of your initial note 
detection scans from a Detection Zone. When a note edit is performed with a note's Handles, sometimes all of the windows are NOT 
automatically redrawn. If you have edited a note, in say the Note Detector Window, and would like to see its new representation in 
the Pitch Viewer Window, you will have to activate the Pitch Viewer Window by clicking inside the window with the mouse. Once the 
new window is activated, it will redraw itself and show any recent note editing changes.  
 
 
1.   Create a New Project and Notelist 
For this tutorial you will need a test Project (created from a Wave file) and a Notelist that has been detected from one of its 
Detection Zones. If you can not remember how to create a Project, a Detection Zone, or a Notelist,  go to Tutorial A and do this now. 
After you have created a Notelist, activate or launch a Note Detector Window. You will need to work on a Note Detector Window for 
the rest of this tutorial. 
 
 
2.   Using Sound Tests to Find A Bad Note 
Erroneous notes (noise-notes) can occur for a number of reasons. Note detection with a low value on the Weak-Note Cutoff Slider 
can create many noise-notes, and a very high setting on the Detection Detail Slider can cause the note detector to create some 
noise-notes, but to a lesser degree than the Weak-Note Cutoff Slider. Noise-notes are typically dark gray in color upon the Note 
Detector window, and sometimes might come from other musical instruments than the solo instrument. To clean up some of the 
noise-notes, you will want to listen to the dark gray notes with the Play Note Tool (Tutorial A, Step 9) and determine which notes are 
complete errors, or have problems that can be fixed.  
 
You can also listen to an isolated note with the Play Current Note Button on the Toolbox (see Step-Play Note Buttons in the 
Glossary of Terms). To use the Play Current Note Button, first select the note with the Selection Tool to establish it as the 'current 
note'. Then, when you hit the Play Current Note Button, the note will play two different tones: 1st) the Wave Recording’s sound for 
the time span of the note, and then  2nd)  the actual note played through the midi SW Synthesizer. If the two tones sound 'similar', 
then you have a valid note. But if the two tones sound very different and the note is dark gray on the Note Detector Window, then 
you might have a noise-note which is really not part of the solo. Also see Play Next Note Button and Play Current Note Button in the 
Glossary of Terms, and take some time to familiarize yourself with the three Step-Play Note Buttons (see Tutorial A, Step 10). 
 
 
3.   Deleting An Irrelevant Note 
Use the Play Next Note Button and Play Current Note Button to find a noise-note in your Notelist. To delete the note you must first 
select the note with the Selection Tool, and then execute the "Cut" command on the Edit Menu. If you change your mind and want 
the note back in the Notelist, execute the "Undo" command on the Edit Menu. Executing the "Delete" command from the Edit will 
remove the note but not allow the Undo menu command to later restore it. 
 
Now select and Cut a note. Then try the Undo command, and observe how the note comes back. You can also use the keyboard to 
cut notes by pressing the Delete key. Now finally remove the noise-note and look for another. Practice using both the Play Note Tool 
and the Play Current Note Button upon the Toolbox to find bad notes. Which is easier for you? Judging a bad note is a little more of 
an art than a science. If you have trouble at first do not get discouraged -- with time and a little practice you will get much better at 
picking out a noise-note.  
 
 
4.   Correcting A Note's Octave  
As previously mentioned, while the note detector can at times be very accurate, it can occasionally make some errors. The most 
common error that the note detector might make is picking the wrong octave while getting the correct ScalePitch (E, F, 
F#,G,G#,A,A#,B,C,C#,D,D#) for the note. For this reason, PitchScope makes it very easy to correct a note's octave value while 
keeping the original ScalePitch value.  
 
Activate the Note Detector Window by mouse-clicking inside it. If you do not see a Note Detector Window on the display, you can 
launch one by going to the View Menu and selecting "Note Detector". Now go to the Tools menu and pick the Selection Tool. Now 
mouse-click on a note and notice its Handles (small squares). The Handle in the middle of the note is used to change the note's 
octave. Mouse-dragging on the Octave Handle in an upward or downward direction to change the octave of the note. 
 
To help you resolve a possibly bad octave assignment, PitchScope gives you numerous tools: various audio tools to help you hear if 
the octave is bad, and a Note Properties dialog box that is launched when you double-click with the mouse upon a note. The dialog 
box contains the scores of the four possible octave candidates for that particular ScalePitch value. Each of the four octave 
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candidates' Primary Scores tell you how well they scored with the octave detector. Usually the correct octave has the highest 
Primary Score. However, if some of the Primary Scores are close (and show a low percentage for Best Primary Score Certainty), 
then the octave detector may have made a mistake in choosing the correct octave. In considering whether or not to change an 
octave value, you can also look at the octave candidates' Closeness Scores. Typically neighboring notes tend to cluster together in 
pitch, and do not jump wildly form octave to octave. If the two highest Primary Scores are close in value and the note does not 
sound right, then you might want to try the octave candidate with the highest Closeness Score.  
 
To hear the note play in its new octave followed by the Wave Recording for the note's duration, mouse-click on the Play Current 
Note Button upon the Toolbox. The three Step-Play Note Buttons are horizontally grouped and are in the middle of the Toolbox. The 
Play Current Note Button is the center button in the group of three. Now mouse-click on the Play Current Note Button and compare 
the note's sound in its new octave to the Wave Recording's tone. By testing and listening to the four octave possibilities with the 
Play Current Note Button, you can correct a bad octave assignment. 
 
Much of the time it is easier to tell if a note has the correct octave by listening to the note play along with some of its surrounding 
neighbor notes. A useful method to focus on a note that needs an octave correction, is to use the Toolbox’s Loop Play Button, which 
is labeled with the text “LP” (Loop Play). To use the Loop Play button, first create a Time-Zone Selection Box around the group of 
notes you are examining. Then press the Loop Play Button, and the same group of notes will play over and over again, until you 
press the Pause Button on the Toolbox. While the music is playing you can even mouse-drag on the Octave Handles to hear what a 
note sounds like in a different octave. And while the music is playing you can also move the Midi/Wave Balance Slider left and right, 
while in the Midi and WAV audition mode, to hear the same group of notes with or without the WAV or Midi-note sounds. 
 
Though a bad octave assignment is rare, it is much more unlikely that a bad ScalePitch assignment would occur by the note 
detector. Take a few minutes to select notes, make adjustments with the Note's Octave Handle and listen to your changes. Can you 
tell when the note is in its correct octave? Also try setting the Audition Mode to Just Midi and see if that makes it easier to spot a 
note that has a bad octave assignment. Correcting octaves can sometimes be a little difficult at first, but with some practice it will 
become much easier with time.    
 
 
 5.   Correcting A Note's Duration   
Sometimes the detector will assign the correct pitch for a note, but its length in time (duration) is slightly incorrect. To correct the 
duration of a note, first open the Note Detector Window by going to the View Menu and selecting "Note Detector". Scroll the window 
to the left or right till the note is in view. Select the note with the Selection Tool. You should then see three Handles (small squares) 
on the note. If you only see one Handle in the middle, it means that the Note Detector Window must be horizontally zoomed-up 
(magnified) so the note has enough horizontal length in order to have room to draw three Handles. To zoom-up the window in the 
horizontal direction, go to the Toolbox and mouse-click on the Horizontal Zoom-Up Button, which is the button with a large 
magnifying glass located at the farthest left of the ToolBox. After zooming-up the window, re-select the note to see if the three 
Handles now have enough room to be drawn. If you still can not see three Handles, repeat zooming-up and re-selecting until the 
three handles have enough room to be drawn.  
 
Now that the note displays its three Handles, mouse-drag on the right handle to stretch the notes duration (i.e. make the note play 
for a longer time). If you want the note to start playing a little earlier or later, mouse-drag on the left Handle. To hear what the note 
sounds like with its neighboring notes, you could hit the Play Window Button on the Toolbox. Take a few minutes to select notes and 
make adjustments with the Note's Start Handle and Note's End Handle.  
 
 
 6.   Merging Two Notes of Same Pitch 
If you have two neighboring notes of the same pitch and octave that you want to merge into one note, you can delete the second 
note and then mouse-drag the first note's right Handle to the point where the second note had previously ended. See if you can find 
two notes of the same Fundamental Pitch (same pitch and octave), and then merge them in to one note.  
 
 
 
 

Tutorial D:   Previewing a Note Detection  
  
You can detect notes on either the Note Detector Window or the Pitch Viewer Window. However, the Note Detector Window is 
preferred because the user can get better visual feedback when testing different control settings along with the Detect button of the 
Detect Notes dialog box. By repetitively hitting the Detect button, the user can visually see the effects of different slider control 
settings, and then fine tune the dialog's controls for the best final note detection. This tutorial will elaborate on Step 6 of Tutorial A 
(Doing A Simple Note Detection), and show you how to use the controls on the Detect Notes dialog box to get better note 
detections. 
 
 
1.   Create a New Project  
For this tutorial you will need to create a test Project (created from a Wave file) for a musical instrument solo. If you can not 
remember how to create a Project or a Detection Zone, go to Tutorial A and do this now. 
 
 
2.   Setting Up the Two Windows for Preview Mode  
Now open up a Note Detector Window. Leave the horizontal magnification (zoom) alone so that you can later see the detail of the 
individual notes. From the Edit Menu choose the Select Entire Detection Zone command so that the entire detection zone is 
selected, even though it may not be fully in view. You will then see a Time-Zone Selection Box as an image in reversed gray colors.  
 
 
3.   Make Multiple Previews of Note Detection Scans  



We will now proceed to do a note detection with the Note Detector Window. If you have forgotten how to detect notes, take a 
moment to review Step 6 of Tutorial A. Now, with the Time-Zone Selection Box visible from Step 2, go to the Detection Menu and 
select "Detect Notes". This will launch the Detect Notes dialog box. 
 
For this tutorial we will be experimenting with the Detection Detail Slider and the Weak-Note Cutoff Slider after multiple presses of 
the Detect button. When using the Detect Notes dialog box, the user can repetitively hit the Detect button while testing different 
settings on the two slider controls. Once the Detect Notes dialog box is launched, PitchScope remembers the Time-Zone Selection 
after successive Detect button presses -- the user does not have to again use the mouse or menu to later make additional Time-
Zone Selection Boxes. Each time that you hit the Detect button, the existing notes in the time selection area are deleted, and 
replaced by a new set of notes that are determined by the new settings on the two slider controls.    
 

                                                    
 
Sliding the Detection Detail Slider control to a maximum value will cause the note detector to respond to the faintest of pitches, so 
much so that a very high setting will pick up noise-notes (i.e. irrelevant notes) from other instruments. And when the slider is set to a 
low value, some relevant notes might be missed, but the amount of noise-notes is at a minimum. 
 
Sliding the Weak-Note Cutoff Slider control to a high value will eliminate notes with a low detection score (as shown by their dark 
gray color). The Weak-Note Cutoff Slider control is useful in preventing too many incorrect noise-notes to be created during a 
detection scan. A high setting will eliminate too many valid notes, and a low setting will not eliminate enough weak erroneous notes. 
Users will want to find the best setting that allows valid subtle notes to be detected, and yet has a minimum amount of noise-notes.  
 
First write down the initial values for both the Detection Detail and the Weak-Note Cutoff sliders. They should be "89" for the 
Detection Detail slider, and "49" for the Weak-Note Cutoff slider. Now hit the Detect button for the first time. If all the notes are a 
faint dark gray color, you may want to check the Boost Volume checkbox and again hit the  Detect button. If you want to hear what 
the notes sound like between different presses of the Detect button, just press the Play Notes button, and then stop the note play 
with the with the Stop Play button. 
 
Now examine the gray notes in the Note Detector Window. Do you see a lot of noise-notes -- lots of little dark notes that do not 
seem to be part of the melody? If so, then you might want to increase the Weak-Note Cutoff slider to get rid of some of the noise-
notes. And if you do NOT see enough relevant and complete notes from the detection scan,  you may need to increase the setting 
on the Detection Detail slider. Remember that, though you may have to do some manual cleanup (deleting noise-notes), it is much 
better to have too many noise-notes, than to miss some relevant notes. If you miss notes, you will have to later manually add them 
with Create Note Tool, which can be very much slower than deleting noise-notes (see Tutorial E: Using the Create Note Tool). It is 
recommended that you first adjust the Detection Detail Slider with some previews from the Detect button, and then later 
fine tune your detection scan with the Weak-Note Cutoff Slider. Hit the Detect button a second first time after adjusting the 
slider controls. Does the new detection scan look better or worse? Keep hitting the Detect button while experimenting with the slider 
control settings till you are satisfied. Then hit the "Save" button to save your new notes to the Notelist while closing the Detect Notes 
dialog box .      
 
 
4.   Evaluating the Note Detection Scan 
Now zoom-up (Horizontal Zoom-Up Button) and scroll the window to get a better look at the new notes. You might also want to open 
a Pitch Viewer Window to get a look at the notes' pitch properties in that graphic format. Notice how the Pitch Viewer Window 
displays the pitch activity inside the notes with clusters of light-gray pixels. 
 
 Now play the new notes with the different Audition Modes. Did you get all the notes you need, or miss some important notes? If you 
are not happy with the detection scan, use either the mouse or the menu's Select Entire Detection Zone command to create a new 
Time-Zone Selection Box, and again hit the Detect Notes menu command. You can then try again with the Detect Notes dialog box 
to get a better detection scan. 
When you eventually get a set of notes that you like, hit the Save button and then proceed to 'cleanup' the note scan as described 
Tutorial C: Editing Some Notes. As said earlier, doing note detection is still more of an art than a science. If at first you have some 
difficulty, do not get discouraged. After practicing on different musical instrument solos, you will eventually find it much easier to 
perform note detection and manual cleanup. When you are done with your note scan, always make sure to close the Detect Notes 
dialog box with either the Save or Cancel button.     
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Tutorial E:   Using the Create Note Tool 
  
The third mouse tool is the Create Note Tool. You can use the Create Note Tool when the note detector has occasionally failed to 
find a note that you can hear in the Wave Recording. By using the Create Note Tool you can manually add new notes to a set of 
notes that were previously created from the "Detect Notes" menu command. Also see Create Note Tool in the Menu Commands 
section of this document. 
 
 
 
1.   Create a New Project and Notelist  
For this tutorial you will need to create a test Project and a Notelist that has been detected from a Detection Zone. If you can not 
remember how to create a Project, Detection Zone, or Notelist,  go to Tutorial A and do this now. 
 
 
2.   Create A New Note   
Go to the Tools menu and select "Create Note". Notice how the mouse's cursor changes shape to that of an i-beam (the same icon 
as on the Toolbox's far left button which also selects the Create Note Tool). Activate the Pitch Viewer Window by mouse clicking 
inside the window. Now scroll to an area where you think that you missed a note that you can still hear. In that time interval, look for 
the strongest cluster of light-gray and white pixels in one of the 12 horizontal ScalePitch Channels. Mouse-click on that cluster of 
light-gray pixels with the Create Note Tool. If you picked correctly and there is some pitch activity in that spot, a new note will be 
created and drawn with a blue rectangle.  
 
 
3.   Listen to the New Note  
Now go back and choose the SelectionTool. Click on the new note with the Selection Tool to establish it as the current note. Then 
mouse-click on the Toolbox's Play Current Note Button, and you will hear two tones: 1st) the Wave Recording's sound for the time 
span of the note, and then  2nd)  the actual note played through the midi SW Synthesizer. If and when the two tones sound the most 
alike, you have correctly adjusted the note's values (Duration, ScalePitch, Octave).  
 
 
4.   Adjusting the New Note   
A note has three properties that you can adjust in PitchScope:  
      1)  Duration     (the beginning and end of the note in time)   
      2)  Octave       (in PitchScope a note can have one of 4 octaves) 
      3)  ScalePitch (E,F,F#,G,G#,A,A#,B,C,C#,D,D#  ...the 12 horizontal channels on the Pitch Viewer Window)  
 
In order for your new note to be correct, you must properly adjust each of these values. First try to determine if the ScalePitch value 
is correct when you play the note with either the Play Current Note Button or the Play Note Tool. If the note sounds very wrong, you 
may have picked the wrong ScalePitch Channel. In that case you would have to delete the note and create another note in one of 
the other ScalePitch Channels, until you choose the correct channel. 
 
When you are satisfied with the ScalePitch setting, then it is time to set the note's Octave setting. Open up a Note Detector Window 
and scroll to find your new note. You may need to look at the values in the Wave's Time Ruler in order to locate the note in the Note 
Detector Window. Select the note and notice that its Octave Handle is in the middle. By mouse-dragging the Octave Handle in a 
vertical direction, you can choose the correct octave. PitchScope has 4 different octaves that you can choose from. Remember to 
evaluate the different possible octaves by playing the new note with either the Play Current Note Button, the Play Note Tool, or Play 
Window Button (all on Toolbox). Also see Tutorial C, Editing Some Notes, Step 4 for a more thorough discussion on adjusting 
Octaves.   
 
And finally, you can adjust the note's Duration (when the note starts playing, when it stops playing) by horizontally mouse-dragging 
the two outer Handles of the selected note. Again you need to listen to your changes in one of the various ways to make sure of 
your choice. If you can not properly adjust your note, you may have to delete the new Note and start all over again.  
 
 
5.   Concurrency Issues   
As stated earlier, PitchScope can only play one note at a time. For that reason, NEVER create a new note so that its time interval 
overlaps the time interval of another note. You must adjust the different notes' durations so that they NEVER overlap or coincide in 
time. 
 
 
6.   And Lastly   
The Create Note Tool is perhaps the most difficult part of the PitchScope interface. If you find yourself constantly going to the Create 
Note Tool to add missing notes, consider trying to use higher settings on the Detection Detail slider control, and lower settings on 
the Weak-Note Cutoff slider of the Detect Notes dialog box (see Tutorial D, Step 3). With a higher setting on the Detection Detail 
slider, and perhaps a lower setting on the Weak-Note Cutoff Slider, you will probably detect the missing notes with the note detector, 
and not have to manually add them with the Create Note Tool. With these settings you may get more noise-notes, but it is much 
easier to delete noise-notes than it is to create new notes with the Create Note Tool.  
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Menu Commands 
 
Before you go ahead and read the features of the menus, and commands of PitchScope, it might be best to step through this 
document's various Tutorials in order to get a basic feel for the application. Technical terms particular to PitchScope are placed with 
first letters in capitals (example: Detection Zone), and can be looked up in the Glossary Of Terms section at the end of this 
document.   
 
  

Main-Window Menus 
  
  

File Menu:   
 
 New Project - Choose this to start a new musical Transcription Project from a Wave(.wav) or MP3 song file. Fill out the 
three fields on the "Create New Project" dialog box and hit the Create button. Ideally the digital song file that you will choose will be 
in an uncompressed Stereo Wave at 44.1 kHz with 16 bit samples format. But if you can not find your song in that format, 
PitchScope also has a built-in MP3 File converter and a Wave File(.wav) converter that can convert other formats to an 
uncompressed Stereo Wave(.wav) at 44.1 kHz format. When you attempt to load a MP3 file, or a Wave file of a different format, 
PitchScope will automatically ask you if you want the conversion to create a second file in uncompressed Stereo Wave(.wav) at 44.1 
kHz format. Select "Yes", and the converter should, in most cases, be able to create the second song file in uncompressed Stereo 
Wave at 44.1 kHz format. If it fails to do the conversion (very rare), you could find or buy a digital music file Conversion Utility to 
make the conversion to an uncompressed Stereo Wave(.wav) at 44.1 kHz with 16 bit samples format. If a file conversion has been 
performed, only the converted version of the file is then needed. Read Tutorial A: Doing a Simple Note Detection. Also read Basic 
Topics (section Working With Sound Files),  and Tutorial B: Extract a Song from an Audio CD, and Convert a MP3 File to Wave 
Format. 
 
 New Notelist - Choose this if you want to create another new Notelist from a Project. The existing Notelist will be 
deleted from memory and a new Notelist will be created that has no notes. You can then use the pitch detector to detect some notes 
from one of the current Project's Detection Zones. See Tutorial A, steps 5 and 6 from this document. 
 
 Load Project - Choose this to load a pre-existing Project File and its Wave File(.wav) into PitchScope. You could then 
create a new Notelist, or load an existing Notelist that was originally created from that Project File. 
 
 Load Notelist - Choose this to load a pre-existing Notelist File into PitchScope. When this command is executed, 
PitchScope will attempt to find the Project File that was used to create this Notelist File -- if it finds the Project File, it will ask you if 
you want to also load the Project File. Most times you will want the Notelist's Project File to be loaded, so that you can also see the 
pitch activity upon the Pitch Viewer Window. 
 
 Load Wave/MP3 - This will allow you to load a digital music file, in either Wave(.wav) or .MP3 format, into PitchScope 
without having to first create a new Project. Do this when you want to first examine a music file to make sure it will be acceptable for 
PitchScope to work with. Technically, an uncompressed Stereo Wave(.wav)  file at 44.1 kHz with 16 bit samples is the only format 
that PitchScope can work with. When you extract Wave Files from Audio CDs, or otherwise acquire music files, always try to save 
them in uncompressed Stereo Wave(.wav) file at 44.1 kHz with 16 bit samples format. However if you can not do this, PitchScope 
also has a built-in MP3 File converter and a Wave File converter that can convert other formats to the desired uncompressed Stereo 
Wave(.wav) at 44.1 kHz format. When you attempt to load a MP3 file, or a Wave(.wav)  file of a different format, the converter will 
automatically ask you if you want the file converter to create a second file in uncompressed Stereo Wave(.wav) at 44.1 kHz format. 
Select "Yes", and the converter should in most cases, be able to create the second music file in stereo Wave(.wav) at 44.1 kHz 
format. If a file conversion has been performed, only the later converted version of the file is needed to later create a new Project. 
Also read in document Basic Topics (section Working With Sound Files),  and Tutorial B: Extract a Song from an Audio CD, and 
Convert a MP3 File to Wave Format.  
    
 Save Project - Choose this to save any modifications that you may have made to the current Project, to its Project File. 
Typical modifications might be the addition, deletion, or modification of Detection Zones, or any changes made through the Project 
Options menu command.  
 
 Save Notelist - Choose this to save your currently loaded Notelist to the last Notelist File that was loaded. If you made 
any edits to the Notelist, you will probably want to save your changes with this command. 
 
 Save Notelist As - Choose this to save your Notelist to a new Notelist File on your hard drive. If you want to save your 
changes to a second, new Notelist, just type in a new filename for the new notelist in the "Save As" dialog's file name-field. 
 
 Project Options - This will launch the "Project Options" dialog box. The dialog box will show which Stereo-Mix Channel 
you have decided to detect from, and the file paths of the Project File and its source Wave(.wav) file. 
 
 Print - Choose this to print out the notes in the Notelist to your printer. The graphic format that displays the notes is 
similar to what you see in the Note Detector window. After selecting this menu command you will see a dialog box that will ask if you 
would like to print only the notes in the currently visible Detection Zone, or print all the notes in the Notelist. Only the notes in the 
visible Stereo-Mix Channel will be printed. 
 
 Exit - This will shut down PitchScope. Make sure to first save any changes to either the currently loaded Project File 
and/or Notelist File. 
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Edit Menu: 
 
 Undo -  Select this after you have made an edit to the currently loaded Notelist. Typical Notelist edits might be the Copy, 
Cut, or Paste of notes, changes to a note's octave, or changes to a note's duration (length in time). This command does NOT work 
with the Delete menu command. 
 
 Cut -  After first selecting a note or notes with the Selection Tool, use this command to remove the note or notes from the 
Notelist. You can also use the keyboard to cut notes by pressing the Delete button. The notes will then be copied to PitchScope's 
Clipboard. 
 
 Copy - Use this command to copy a Note or notes to PitchScope's clipboard.  
 
 Paste -  Use this command to paste a Note or notes from PitchScope's clipboard to the currently loaded Notelist.  
 
 Delete - After first selecting a Note or notes with the Selection Tool, use this command to delete the note or notes from 
the Notelist. The Undo menu command will NOT work with this command. If you anticipate the need for an Undo, use the Cut 
command instead. 
 

Select Entire Detection Zone - Use this command before you detect notes for an entire Detection Zone. This is an 
easier way to select a Detection Zone than creating a Time-Zone Selection Box with handles, and can allow selection when not all 
of the Detection Zone can fit in the window.  
 
 Select All Notes In DZone - This command will select all the notes in the Detection Zone that is currently visible in the 
window. If more than one Detection Zone is visible in the window, you must horizontally scroll and/or Zoom-Up the window so that a 
portion of only one Detection Zone is visible. It is acceptable if only part of the Detection Zone is visible in the window.  
 
 
 
 
 
 

View Menu: 
  

Display Center - Choose this when you want PitchScope to display notes and Detection Zones from the combined 
sound of both left and right stereo channels of the original Wave Recording. At any time you can choose one of three Stereo-Mix 
Channels (center, left, right) to work with. Suppose you were to create a Detection Zone and Notelist in the left channel, and you 
then used this menu command to switch to the center channel -- you would then NOT be able to see or hear the notes that you 
created in the left channel. Only the notes and Detection Zones that you created in the center channel would be visible with this 
menu command checkmarked. However, a Notelist and Notelist File may contain notes from all three channels if you wish. For most 
digital song files this Display Center setting will give the best results, as most instrumental solos are typically mixed with equal 
volume into both left and right stereo channels. Also see Glossary of Terms section for Stereo-Mix Channel.   
 
 Display Left Stereo - Choose this when you want PitchScope to display notes and Detection Zones from only the left 
stereo channel of the original Wave recording. This would be appropriate if the instrumental solo was mixed so that the instrument's 
volume was mostly in the left channel, with little volume in the right channel. Also see Glossary of Terms section for Stereo-Mix 
Channel.   
 
 Display Right Stereo - Choose this when you want PitchScope to display notes and Detection Zones from only the 
right stereo channel of the original Wave recording. This would be appropriate if the instrumental solo was mixed so that the 
instrument's volume was mostly in the left channel, with little volume in the left channel. Also see Glossary of Terms section for 
Stereo-Mix Channel.   
 
 Note Detector -  This launches the Note Detector Window. Go to the Window Diagrams section of this document to see 
a picture of this window. This window is primarily used to view and play the loaded Wave File, and to create Detection Zones of the 
instrumental solo portion of the Wave recording. In the Note Detector Window, unlike the Pitch Viewer Window, notes are displayed 
with their octave values and appear as they would in a Piano Roll Format. The higher pitched notes are at the top, and the lower 
ones are at the bottom. It is here that you will make edits to notes that may need some minor corrections. Unlike the Pitch Viewer 
Window, when a note is selected here with the Selection Tool, it has three handles (small squares) on its beginning, end, and in the 
center. As with the Pitch Viewer Window, the left and right handles can be horizontally dragged to change where a note starts or 
ends. But the center handle, when mouse-dragged vertically will change the note's Octave. And as the Pitch Viewer Window, right 
mouse-clicking on this window will launch Popup Menu from which you can select "Toggle Note Text" to either show or hide each 
note's letter name. To learn more about pitch detection on the Note Detector Window, step through Tutorial A: Doing a Simple Note 
Detection, and to learn more about editing notes on the Note Detector, step through Tutorial C: Editing Some Notes.    
 
 Pitch Viewer - This launches the Pitch Viewer Window. Go to the Window Diagrams section of this document to see a 
picture of this window. The Pitch Viewer Window shows pitch activity in the 12 horizontal ScalePitch Channels corresponding to the 
12 ScalePitches of the musical scale (E,F,F#,G,G#,A,A#,B,C,C#,D,D#). Here the notes are displayed without their octave 
information. The white and light gray clusters of pixels indicate a possible note in a given ScalePitch Channel. Right mouse-clicking 
on this window will launch a popup menu from which you can select "Toggle Note Text" to either show or hide each note's letter 
name. When a note is selected with the Selection Tool, it shows two Handles (small squares) on its beginning and end. Mouse-
dragging horizontally on a Handle can change where a note starts and/or ends.  



 27

 
 Revolver Animation -  This launches the Revolver Animation Window. This animation window do not allow editing, but 
attempts to better display the current playing note by only rendering that current note while it plays. It is called the 'Revolver' 
because the 12 ScalePitch values are displayed in a circular format. 
 
 Mountain Animation -  This launches the Mountain Animation Window. Like the Revolver Window, this animation 
window does not allow editing, but attempts to better display the current playing note with an animated graph of moving 'mountains' 
that are rotated sideways. 
 
 Close All - This will close all of PitchScope's windows except for the Toolbox. 
 
 
 
 
 

Tools Menu:  
   
 Select (tool) - This will change the current mouse tool to the Selection Tool, and then the mouse's cursor will take on 
the shape of an arrow. To see a summary of the Selection Tool's uses, read the Selection Tool’s definition in the Window Diagrams 
section, Toolbox Window sub-section. And to learn more about the uses of the Selection Tool, step through Tutorial A: Doing a 
Simple Note Detection, and Tutorial C: Editing Some Notes.  
 
 Play Note (tool) - Select this and the current mouse tool will change to the Play Note Tool. This will change the 
mouse's cursor to the shape of an oval with two cross hairs. To see a summary of the Play Note Tool's uses, read the Play Note 
Tool’s definition in the Window Diagrams section, Toolbox Window sub-section. And to get some experience using the Play Note 
Tool, step Tutorial A: Doing a Simple Note Detection, Step 9.   
 
 Create Note (tool) -  Select this and the current mouse tool will change to the Create Note Tool, and the mouse's 
cursor will change to the shape of an i-beam. Use the Create Note Tool to manually create a note that the note detector might have 
missed. To see a summary of the Create Note Tool's uses, read the Create Note Tool’s definition in the Window Diagrams section, 
Toolbox Window sub-section. And to get some experience using the Create Note Tool, step through Tutorial E: Using the Create 
Note Tool. 
 
 Options -  This launches the Application Options dialog box. Upon the Midi Playback groupbox you can change the 
current Midi musical instrument that you hear playing the notes in the notelist. Picking a different Midi instrument will change the 
sound of the SW Synthesizer's play of the Notelist to perhaps that of a clarinet, a saxophone, Hammond organ, or various other 
musical instruments. Many times a Midi instrument is referred to as a Midi Instrument Patch Number. To change the current Midi 
instrument, just input a new patch number between 0 and 95 into the textbox, or scroll to a new number with the arrow controls. Also 
see Midi, SW Synthesizer, and Midi Instrument Patch Number in this document's Glossary of Terms.  
 
When simultaneously listening to the Notelist and the WAV recording (from the Midi and WAV audition mode), it is necessary to 
have the two musical sources be synchronized in time. Because different microprocessors and sound hardware sometimes execute 
midi play commands with different response times, PitchScope must sometimes have its Timing-Advance Factor altered to fine tune 
the synchronization of play. If the play of the midi notes sounds a little out of beat with the play of the source WAV file, you can then 
you can correct the problem by adjusting the Timing-Advance Factor upon the Options dialog. When changing the Timing-Advance 
Factor with the arrow controls, notice how the Possible Processor Speed values change for the different Timing-Advance values. 
Keep in mind that the Possible Processor Speed values for speed and operating system are only rough approximations -- you will 
have to ultimately test the synchronization by listening to each of the different settings. It may be that you ultimately need a setting 
that is different than your actual processor speed and/or operating system.    
 
Here is how to set the Timing-Advance Factor: first use the arrow controls to scroll through the different values, and stop at the 
number whose Possible Processor Speed best describes your computer. Now, with the audition mode set to Midi and WAV, load 
and listen to a Notelist that you have detected from a WAV. Try to notice if the Notelist sound a little out of beat with the WAV 
recording. Now change the Timing-Advance Factor to a number that is one higher that the current setting. Again listen to the Notelist 
and WAV play. Does it sound more or less in sync? Now try a Timing-Advance Factor that is one less than your first value, and 
listen to the Notelist again. Does this sound better? By testing different values for the Timing-Advance you will eventually zero in on 
the correct setting.    
 
Note: PitchScope can not remember between sessions what values you entered for the Timing-Advance Factor or the Midi 
Instrument Patch Number. If the Timing-Advance Factor for your computer is different than the default setting, you will have to 
manually enter it at the start of each session. However, the Timing-Advance Factor and Midi Instrument Patch Number are 
automatically saved to both Notelist files and the Project files, so that any time that you load a Notelist or Project file, your custom 
settings will also be loaded and set.  
 
 
 
 
 

Audition Menu: 
  

Midi and Wave - This is the first of three ways to listen (i.e. Audition Modes) to the Wave Recording and/or the Notelist. 
After choosing this command, the Midi and Wave mode will simultaneously play both the Notelist(by internal Midi device) along with 
the source Wave Recording(.wav). When in the Midi and Wave mode, you will want to be able to equally hear both the Midi play of 
the Notelist and the original Wave recording. To do this you can use the horizontal Midi/Wave Balance Slider control on the ToolBox 
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to increase or decrease the dominance of the Wave Recording relative to the volume of the Notelist. Moving the slider to the right 
will reduce the volume of the Wave, so that the Midi play of the Notelist will appear louder by comparison. Also see  Midi/Wave 
Balance Slider, Audition Mode, SW Synthesizer, and Notelist in this document's Glossary of Terms.     
 

Just Midi - This is the second of three ways to listen to the Wave Recording and/or the Notelist. The Just Midi mode will 
only let you hear the playing notes from the Notelist through the midi SoftWare Synthesizer. Also see SW Synthesizer, Midi, and 
Audition Mode in this document's Glossary of Terms.   
 

Just Wave - This is the third of three ways to listen to the Wave Recording and/or the Notelist. The Just Wave mode will 
only let you hear the source Wave Recording(.wav) of the song. The three Audition Modes are useful when correcting the 
occasionally errors from that occur form the note detector. Also see Audition Mode and Midi/Wave Balance Slider in this document's 
Glossary of Terms.    
 
     --------------------------- 
 

Source WAV File - Selecting this, instead of Notelist-Only Separation or Background-Only Separation, will cause the 
playing WAV file to be that of the original source WAV file that was used to detect notes. This is the default setting for any new 
Projects or just loaded WAV files.    
 

Notelist-Only Separation -  Selecting this, instead of Source WAV File or Background-Only Separation, will cause the 
playing WAV to be from a Separation WAV file that has only the WAV’s sounds of the notes contained in the Notelist from the 
original source WAV file. See the Create Notelist-Only Separation menu command of the ReSynthesis Menu for a description of 
how the separation wave file is created and used.     
 

Background-Only Separation -  Selecting this, instead of Source WAV File or Notelist-Only Separation, will cause 
the playing WAV to be from a Separation WAV file that has all the WAV’s sounds of original source WAV file except for the sounds 
of the notes contained in the Notelist. The notes are stripped away from a copy of the source WAV file in much the same way that a 
karaoke recording has the singer's voice erased from the original recording. See the Create Background-Only Separation menu 
command of the ReSynthesis Menu for a description of how the separation wave file is created and used.     
 
 
 
 
 

Detection Menu: 
 
 Create DetectionZone - This will create a new Detection Zone from which the note detector will later be able to detect 
notes for a Notelist. Before hitting this menu command, you must first pick the best Stereo-Mix Channel to focus your detection 
upon. Then the Selection Tool is used to create a Time-Zone Selection over the entire length of the instrumental solo. As pitch 
detection can sometimes be slow and consume much memory, NEVER make a Detection Zone for the entire length of a song. Only 
create Detection Zones where you really need them, like in musical instrument solos. Read a summary of Detection Zone creation in 
Creating Detection Zones of the Detection Topics section of this guide, and make sure to step through Tutorial A: Doing a Simple 
Note Detection before attempting this command. 
 
 

Detect Notes - After a Detection Zone has been created, you can then use this command have the note detector find 
the notes within the instrument's solo. You may detect notes on either Note Detector Window or Pitch Viewer Window. However, the 
Note Detector Window is preferred because the user can preview the effects of many different settings with the Detect button from 
the Detect Notes dialog box, and then visually fine tune the dialog's slider controls for final detection. In order to use this menu 
command, you must first use Selection Tool to create a Time-Zone Selection Box over an existing Detection Zone. The Time-Zone 
Select Box shows the image in reversed gray colors and has two Handles with which to fine tune the borders of the Time-Zone 
Selection Box. With the Time-Zone Select Box displayed, hit this command and the Detect Notes dialog box will be launched.  
 Upon the Detect Notes dialog box, sliding the Detection Detail Slider control to a maximum value will cause the note 
detector to respond to the faintest of pitches, so much so that a very high setting will pick up 'noise-notes’ (irrelevant notes) from 
other instruments. And when the slider is set to a very low value, some relevant notes might be missed but the amount of noise-
notes is at a minimum. Users will want to find the best setting that allows subtle notes to be detected, and yet has a minimum 
amount of noise-notes. Irrelevant noise-notes can easily be deleted with Edit Menu commands like Cut and Delete. 
 Similarly, sliding the Weak-Note Cutoff Slider control to a high value will eliminate notes with a low detection value (shown 
by their dark gray color). The Weak-Note Cutoff Slider control is the most useful in preventing incorrect noise-notes during a 
detection scan. A high setting will eliminate too many valid notes, and a low setting will not eliminate enough weak erroneous notes. 
Users will want to find the best setting that allows valid subtle notes to be detected, and yet has a minimum amount of noise-notes. 
Remember that after the note detection scan you will have to manually delete any noise-notes that remain. 
 When using the Detect Notes dialog box with the Note Detector Window, the user can repetitively press the Detect button 
while testing different settings on the sliders, and observe the nature of the different note detection scans. Do not worry if the Time-
Zone Select Box disappears after the first Detect button hit, the computer will remember the original Time-Zone Selection values for 
later Detect button hits. If you want to experiment with the two slider controls, you can repetitively change the slider settings and hit 
the Detect button to see what the detection note scans will look like on the Note Detector Window. When the Detect Notes dialog 
box is launched, the sliders are preset to a reasonable values. When you are finally happy with a note detection scan, hit the Save 
button and the notes will be saved to the currently loaded Notelist. 

It is recommended that you first adjust the Detection Detail Slider with some previews from the Detect button, 
and then later fine tune your detection scan with the Weak-Note Cutoff Slider.  

Go to Automatic Note Detection in the Detection Topics section to read a summary of the note detection process and step 
through Tutorial A: Doing a Simple Note Detection. And also step through Tutorial D: Previewing a Note Detection to get a better 
feel for using the Detection Detail Slider and Weak-Note Cutoff Slider controls. 
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ReSynthesis Menu: 
 
The ReSynthesis Menu commands allow you to create new, modified WAV files (called Separations), derived from the source WAV 
file that you used to make your Notelist. The Separations modify a copy of the original WAV file by using the notes in the Notelist to 
either isolate or subtract the sounds of the notes from the original WAV file. If you want to copy and save the new Separation File, 
you can find it in the same folder as the original source WAV file. You must have a Notelist loaded for these commands to be able to 
work. The Separation WAV is a normal WAV file that is independent of PitchScope, and can be played on any WAV player or 
burned to Audio CD. Creating the Separation Files does NOT change the original source WAV file, which should never be changed 
by you. Separation WAV files can be played instead of the original source WAV file by going to the Audition Menu and choosing 
either Notelist-Only Separation or Background-Only Separation. Detection Zones should never be created from Separation Files. 
 
  

Create Notelist-Only Separation – This command creates a new WAV Separation File by copying only the time-
segments and tones of the original source WAV where there exists a note fromthe Notelist. The result is a new WAV file that only 
contains the sounds of the solo notes of the Notelist. This new WAV file will have the same name as the original source WAV file, 
but with "_lead" added to the file name (ex:  MySong.wav will create the new file, MySong_lead.wav).  
 You can test your edits to the Notelist with this command -- after creating the Separation WAV, go to the Audition Menu 
and select "Notelist-Only Separation". Now when you hit the play button you will hear the Notes-Only WAV instead of the original 
source WAV file. If you have missed some notes or have incorrect notes, it should become obvious where the problems are when 
you listen to the Separation WAV. Then go back to the Note Detector Window and edit the incorrect notes, and possibly make 
existing notes longer in length. After the edits, execute this command again to create another revised Separation WAV, and see if it 
sounds more better.     
 

Create Background-Only Separation – This command creates a new WAV Separation File by copying everything 
but the time-segments and tones of the original source WAV where there exists a note from the Notelist. The result is a new WAV 
file that plays the accompaniment of the song, but without the sounds of the solo notes of the Notelist. This is similar to the way 
karaoke files are made that strip out the singers voice. As in karaoke, you can practice the solo's notes along with this WAV, without 
hearing the original recording's notes of the solo. Playing along with the Background-Only Separation can be an excellent way to 
train yourself to play the solo as you would in a band. To hear the new  Background-Only Separation after doing this command, go 
to the Audition Menu and select "Background-Only Separation". Now when you hit the play button you will hear the Background-
Only WAV file instead of the original source WAV file. The new Background-Only Separation WAV file will have the same name as 
the original source WAV file, but with "_bground" added to the file name (ex:  MySong.wav will create the new file, 
MySong_bground.wav). Listening to the Background-Only Separation can also be a good way to test the accuracy of the Notelist. If, 
while listening to the Background-Only Separation in WAV-only audition mode, you can still hear some notes of the solo, then you 
must go back and add those missing notes to the Notelist, so that they may be later stripped out with a new separation file.       
 
 
 
 
 

Help Menu: 
  

Help Topics - This launches a dialog box that leads to PitchScope's Help Files. Inside the Help Files are window 
diagrams, descriptions of menu and button commands, a Glossary of Terms, and assorted tutorials.  

 
Note: If the Help Files do NOT appear after selecting this command and you are running Microsoft Vista, you will have to download 
a patch from Microsoft to fix this problem. Learn how to get the Microsoft patch file by reading the Know Issues topic on the 
Installation page of this document (pp. 3)     
 

About PitchScope - This launches the About PitchScope dialog box which displays the copyright information for this 
application, and Creative Detectors contact information. 
 

 
 
 
 
 
 
 



 
        The Popup Menu 

  
 
 
 
 

                                                
                           
 
                                               The Popup Menu after selecting  "Toggle Note Text" 
                                                   [  the notes now show their letter names (F, E, D, A#, G)  ] 
 
 
 
 
 
The Popup Menu is launched by clicking with the right mouse button inside an empty area of either the Pitch Viewer Window or the 
Note Detector Window. Once the Popup Menu is visible (see diagram below), click with the mouse's left button on the desired menu 
command (example: "Toggle Note Text"). 
 
 
 
  

Toggle Frame Advance - When you hit the Toolbox's Play Forward Button on a new window, both the Pitch Viewer 
and Note Detector windows' image will only move forward when the last note in the window has played. This is called the "Hopping 
Frame Advance" mode. Now if you select this menu command, the window's image will slowly move forward during the entire play, 
and a bouncing red ball will converge on each currently playing note. This slowly moving image mode is called the "Smooth  Frame 
Advance" mode. The Smooth Frame Advance mode uses a lot of microprocessor resources, and should only be used of computers 
with fast microprocessors. If your microprocessor is too slow to support this mode, the play will be choppy and the sound will be 
bad. For this reason it is always much easier on the microprocessor if you only use the Smooth Frame Advance mode on the Note 
Detector Window, instead of the more demanding Pitch Viewer Window. If you again select this menu command from the Smooth 
Frame Advance mode, it will toggle the setting back to the Hopping Frame Advance mode. 

 
     

Toggle Note Text - Normally a window does not show the notes' letter names (C,C#,D,D#... B). If you select this menu 
command it will display the letter names for each note (see diagram below). And if you again select this menu command, it will 
toggle the setting back to not showing the notes' letter names. 
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Glossary of Terms 
 
Definitions are listed in alphabetical order. 
 
 
 
Audition Mode - PitchScope has various ways that the user can listen to the original Wave Recording and/or the Notelist. The 
Notelist and the Wave Recording use two different devices to play. The two devices are:  1) the Wave Player (plays the .WAV File 
that you loaded),  and  2) the midi SW Synthesizer (plays the individual notes in the Notelist). The three Audition Modes, which can 
be changed from the Audition Menu, are 1) Midi and Wave,  2) Just Midi  and  3) Just Wave.  
 The Just Wave mode will only let you hear the source Wave Recording of the song during the play command.  
 The Just Midi mode will only let you hear the notes of the Notelist playing through the midi SW Synthesizer.  
 The Midi and Wave mode will simultaneously play both the Notelist along with the Wave Recording. With this mode you 
can use the Midi/Wave Balance Slider control on the ToolBox to increase or decrease the dominance of the Wave Recording 
relative to the volume of the Notelist. Moving the slider to the left will reduce the volume of the Wave, so that the Midi play of the 
Notelist will appear louder by comparison.  
 To change the current audition mode, go to the Audition Menu and select one of the three modes. These modes are 
useful when correcting the occasionally errors that might occur from note detection. Also see SW Synthesizer, Midi, and Midi/Wave 
Balance Slider in this glossary.  
 
Background-Only Separation -  Besides being able to listen to the source WAV file that the Notelist was detected from, you 
can also create two types of Separation WAV files that can be listened via settings on the Audition Menu. The Background-Only 
Separation WAV file is made from the ReSynthesis menu, and is a modified WAV file that has all the sounds of original source WAV 
file except for the sounds of the notes in the Notelist. The notes are stripped away from a copy of the source WAV file in much the 
same way that a karaoke recording has the singer's voice erased from the original recording. Also see Create Background-Only 
Separation menu command and the Audition Menu's Background-Only Separation menu command. 
 
CD Ripping Software - The songs that are on your Audio CDs are stored in a Wave File format. With CD Ripping Software, or 
perhaps some Wave Editor software, you will be able to copy the Wave song files from your Audio CDs to your hard drive. Once the 
Wave song files are on your hard drive, you can use them as a source for your PitchScope transcription Projects. The preferred 
Wave format for PitchScope, which also happens to be same as the native Wave format on an Audio CD, is an uncompressed 
Stereo Wave(.wav) at 44.1 kHz with 16 bit samples. If you always 'rip' or copy the song files from the CD in that format, then you will 
have the best sound quality and PitchScope can skip the step of conversion from another file format. See Wave File in this glossary. 
Also see Working With Sound Files of the Basic Topics section in this document. And also read Tutorial B: Extract a Song from an 
Audio CD, and Convert a MP3 File to Wave Format. 
 
Create Note Tool - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Create Note Tool 
Button.  
 
Detection Detail Slider - This slider control is located on the Detect Notes dialog box, which is seen after the user executes the 
Detect Notes menu command on the Detection Menu. Sliding this control to a maximum value will cause the note detector to 
respond to the faintest of pitches, so much so that a very high setting will pick up 'noise' or irrelevant notes from other instruments. 
And when the slider is set to a low value, some relevant notes might be missed but noise is at a minimum. Users will want to find the 
best setting that allows subtle notes to be detected, but yet has a minimum amount of noise-notes. When using the Detect Notes 
dialog box with the Note Detector Window, the user can repetitively hit the Detect button while testing different settings on the slider, 
and observe the effects of the different detection slider settings. When the Detect Notes dialog box is launched, the slider is already 
set to a reasonable value. Step through Tutorial A: Doing a Simple Note Detection,  and Tutorial D: Previewing a Note Detection.    
 
Detection Zone -  When transcribing an instrument's solo, the user must first create a Detection Zone upon the Note Detector 
Window while a Project is loaded. The Detection Zone is created by mouse-dragging the mouse horizontally with the Selection Tool 
to create a Time-Zone Selection Box. With the Time-Zone Selection Box displayed, the user then selects "Create Detection Zone" 
from the Detection menu. Creating the Detection Zone is the first step in detecting notes from the Wave Recording and its 
associated Project File. After a Detection Zone is created, the user can then execute the "Detect Notes" menu command from the 
Detection menu to create the new Notelist. The Detection Zone information is stored in the Project File. To learn more about 
Detection Zones, read Creating Detection Zones in the Detection Topics section of this document. And to get some experience 
creating Detection Zones, step through Tutorial A: Doing a Simple Note Detection. 
 
Detect Zone End Button -  Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Detect 
Zone End Button.  
 
Detect Zone Start Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Detect 
Zone Start Button.  
 
File’s End Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up File's End 
Button.  
 
File’s Start Button -  Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up File's Start 
Button.  
  
Fundamental Pitch - The Fundamental Pitch is the pitch type that we typically associate to a note on the musical staff. The 
Fundamental Pitch has an Octave value for the note. Also see ScalePitch and Octave in this glossary.  
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Handle - A Note can be selected with the Selection Tool by mouse-clicking inside the note's rectangle. When selected, a note is 
displays one, two, or three handles which appear as small hollow squares. Handles may be dragged with the mouse while the left 
mouse button is depressed. By dragging the handles you can edit a note's properties. The Time-Zone Selection Box also displays 
handles that can be mouse-dragged to make the Time-Zone Selection Box bigger or smaller. Also see Selection Tool  in this 
glossary, and step through Tutorial C: Editing Some Notes. 
 
Horizontal Scroll Knob - A standard Windows control that is located at the very bottom of a window. Mouse-dragging 
horizontally on the knob will scroll the viewable section of the Wave Recording and Notelist, forward or backwards in time. The 
specific time location of the Wave's image is written on the Wave's Time Ruler. See this document's Window Diagrams section, the 
Note Detector Window diagram. Also look up Wave's Time Ruler in this glossary.   
 
Horizontal Zoom-Up Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up 
Horizontal Zoom-Up Button.  
   
Horizontal Zoom-Down Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up 
Horizontal Zoom-Down Button.  
 
Midi - Midi stands for "Musical Instrument Digital Interface", and is a set of commands for storing and transmitting information about 
music to computers and electronic devices. MIDI output devices (MIDI musical instruments) interpret this information and use it to 
synthesize musical notes. PitchScope uses Microsoft Windows' internal midi SW Synthesizer (SoftWare Synthesizer) to generate 
the notes that you hear from the Notelist. Also see SW Synthesizer and Midi Instrument Patch Number in this glossary.    
   
Midi Instrument Patch Number - The Midi output device, or in PitchScope's case Window's internal midi SoftWare 
Synthesizer, allows the user to change the midi musical instrument that currently plays the notes in the Notelist. 'Patch' is a 
nickname for a midi musical instrument setting. A table of numbers (0-95) references the various musical instrument sounds that 
you can choose to play the Notelist. To change the current Midi instrument, open the application Options dialogbox with the 
“Options” menu command on the Tools Menu. For example, entering "41" into the Options dialogbox’s textbox for "Midi Instrument 
Patch Number" will give you the sound of a viola (our favorite for electric guitar solos). Entering "64" will makes a soprano sax 
sound, entering "16" will give a Hammond organ sound, etc. Also see SW Synthesizer and Midi in this glossary.  
 
Midi Timing-Advance Factor -  When simultaneously listening to the Notelist and the WAV recording (from the Midi and WAV 
audition mode), it is necessary to have the two musical sources be synchronized in time. Because different microprocessors and 
sound hardware sometimes execute midi play commands with different response times, PitchScope must sometimes have its 
Timing-Advance Factor altered to fine tune the synchronization of play. If the play of the midi notes sounds a little out of beat with 
the play of the source WAV file, you can then you can correct the problem by adjusting the Timing-Advance Factor on the Options 
dialog. You can open the Options dialog from the Tools menu by selecting "Options..."  To learn how to set the Timing-Advance 
Factor, read about it in the Options Dialog portion of the Menu Commands, Tools Menu sub-section of this document.   
 
Midi/Wave Balance Slider -  Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up 
Midi/Wave Balance Slider.  
 
Mountain Animation Window - This is one of several animation windows whose sole purpose to vividly display the current 
playing note, so that the user can practice along with the Wave Recording and/or Notelist. It is nicknamed the 'Mountain' window 
because the animation looks like moving 'mountains' rotated sideways. 
 
Mouse-Click  - Within PitchScope's documentation, this refers to the act of clicking inside a window with the mouse's left button. If 
the right button is to be used, it will be explicitly mentioned. 
 
Mouse-Dragging -  Within PitchScope's documentation, this refers to the act of pressing down with the mouse's left button, and 
dragging the mouse while still holding down the button, and finally releasing the button at a specified location.  
 
MP3 File - This is a type of digital music file that is frequently used on the Internet. Because it is compressed, its fidelity will not be 
as good as an uncompressed Stereo Wave File(.wav) format at 44.1 kHz with 16 bit samples. Though PitchScope can work with 
MP3 files as a source, it is much better to use an Uncompressed Stereo Wave(.wav) format at 44.1 kHz with 16 bit samples, if 
possible. Also read the Working With Sound Files section of this document. 
 
Noise-Note -  An automatic note detection scan, performed from the Detect Notes menu command, attempts to find and identify 
all the notes in a musical instrument solo as it builds a new Notelist. However a note detection scan is not perfect, and if the Weak-
Note Cutoff Slider control is set too low, the note detector will pick up erroneous notes from other instruments -- these incorrect 
notes are called 'Noise-Notes', and must be manually deleted by the user in creating an accurate Notelist of the musical instrument 
solo. Noise-notes typically have a low Detection Value (i.e. weak-note) which is represented by the dark gray color of the note on 
the Note Detector window. A good note detection scan depends on the user correctly setting both the Detection Detail Slider and the 
Weak-Note Cutoff Slider controls upon the Detect Notes dialog box. Remember, that just because a note has a dark gray color does 
not necessarily mean that it is a noise-note. Some valid notes of the solo that are hard to detect will have a dark gray color. See the 
tutorials for a better discussion on the proper use of the Detection Detail Slider and Weak-Note Cutoff Slider controls.  
 
Note -  Notes are the separate parts of a Notelist that PitchScope creates with its note detector. Within PitchScope's graphic 
interface, a note is typically represented by a rectangle. On the Pitch Viewer Window a note is shown with hollow blue rectangles, 
and on the Note Detector Window the notes are drawn as solid gray rectangles. A very light gray color means that the note had a 
strong detection value, and is probably a valid note within the instrument's solo. A note with a very dark color means that its 
detection value was weak, and the note might be an error by the note detector. Also see Notelist in this glossary.   
 
Note Detector Window - Go to this document's Window Diagrams section, Note Detector Window sub-section, to see a picture 
of the Note Detector Window. If a Note Detector Window is not already displayed, you can open one from the View Menu by 
selecting "Note Detector." When you start a new transcription Project, you will first work with the Note Detector Window. After 
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creating the new Project by selecting a source Wave(.wav) or MP3 file, you will see the digital Wave Recording displayed in the 
Note Detector Window as a series of vertical bars that represent the volume of the recording at various points in time. You would 
then create a Detection Zone of the musical instrument's solo. The next step is to do a note detection within the Detection Zone to 
create a new Notelist. After doing a note detection scan, you will likely need to 'clean up' a few errors that might have occurred from 
the note detector. Sometimes a note might just need a minor adjustment, and sometimes the note might be entirely wrong and need 
to be deleted. The graphic animations of the Note Detector Window also become useful as a visual learning-aid, when users 
practice along with the playing Notelist. Read the Cleaning Up Notelists section, and step through Tutorial C: Editing Some Notes. 
 
Note's End Handle - A note can be selected by mouse-clicking inside the Note's rectangle with the Selection Tool. The selected 
note will then display one, two, or three Handles, which look like small hollow squares.  
 A Note's Start and End Handles will only appear in a window if the note is wide enough to fit the rendering of multiple 
handles. If, while mouse-clicking inside the note with the Selection Tool you only see one handle, go to the Toolbox and press the 
Horizontal Zoom-Up button as many times as necessary so that the note is finally wide enough to fit the renderings of multiple 
handles.  
 The handle at the far right is the Note's End Handle, and can be mouse click-and-dragged to change the time value for 
the end of the note. See Note and Selection Tool in this glossary. Also see this document's Window Diagrams section, the Note 
Detector Window diagram.   
  
Note's Octave Handle -  The Note's Octave Handle will only appear on Note Detector Windows. The Octave Handle is the 
handle in the center, and if you only see one handle it is the Octave Handle. If you mouse-drag the Octave Handle in a vertical 
motion, you will change the note's Octave value while keeping the same ScalePitch value. The most common error for the note 
detector is to get the Octave wrong while setting the ScalePitch correctly. So to make your cleanup of a note detection easier, the 
octave value can be easily changed by this handle without altering the note's ScalePitch value. As you try different octave values, hit 
the Toolbox's Play Current Note Button and you will hear two successive tones: 1st) the Wave Recording's sound for the time span 
of the note, and then  2nd)  the actual note played through the midi SW Synthesizer. After testing all four octave positions, you will 
know when you have picked the correct note when the two tones from the Play Current Note Button sound the most alike. Also, if 
you mouse double-click upon the Note, the Note Properties dialog box will be launched. Upon it you will see the various ratings for 
the 4 different octave possibilities -- you should use them when editing an octave assignment. See Octave and ScalePitch in this 
glossary, and read Cleaning Up Notelists in the Detection Topics section. Also see this document's Window Diagrams section, Note 
Detector Window sub-section. And also read Tutorial C: Editing Some Notes, step 4: Correcting A Note's Octave.  
   
Note Properties Dialog Box - The Note Properties dialog box is launched when you double-click with the mouse on an 
individual note. It contains various measurements of the note: the note's ScalePitch Value, the note's Detection Score, and the 
scores of the four possible octave candidates for that particular ScalePitch value. The note's Detection Score is in percent and 
represents the note detector's certainty that this is indeed a valid note and not a Noise-Note. When the percentage is low, consider 
the possibility that the note detector might have incorrectly created a noise-note that must be manually deleted. Each of the four 
octave candidates' Primary Scores tell you how well they scored with the octave detector. Usually the correct octave has the highest 
Primary Score. However, if some of the Primary Scores are close (and show a low percentage for Best Primary Score Certainty), 
then the octave detector may have made a mistake in choosing the correct octave. In considering whether or not to change an 
octave value, you can also look at the octave candidates' Closeness Scores. Typically neighboring notes tend to cluster together in 
pitch, and do not jump wildly form octave to octave. Therefore, when you have doubts whether or not the Primary Score chose the 
correct octave, you can also resort to the Closeness Score -- usually the correct octave candidate will also have the highest 
Closeness Score. The note's current octave value can be changed by mouse-clicking on the radio buttons in the Octave Selection 
group box. Also see Tutorial C: Editing Some Notes, Correcting A Note's Octave. 
 
Note's Start Handle - A note can be selected by mouse-clicking inside the Note's rectangle with the Selection Tool. The selected 
note will then display one, two, or three Handles, which look like small hollow squares.  
 A Note's Start and End Handles will only appear in a window if the note is wide enough to fit the rendering of multiple 
handles. If, while mouse-clicking inside the note with the Selection Tool you only see one handle, go to the Toolbox and press the 
Horizontal Zoom-Up button as many times as necessary so that the note is finally wide enough to fit the rendering of multiple 
handles.  
 The handle at the far left is the Note's Start Handle, and can be mouse-dragged to change the time value for the start of 
the note. Most of the time the note detector will do a good job of setting this value, but at times you may want to make minor 
correction. See Note and Selection Tool in this glossary. Also see this document's Window Diagrams section, the Note Detector 
Window diagram.   
 
Notelist - The main purpose of PitchScope is to detect and save the individual Notes of a Wave Recording's musical instrument 
solo. The individual Notes of an analyzed solo are grouped into a Notelist and can be saved to hard drive as a Notelist File. 
PitchScope uses Microsoft Windows' internal midi SW Synthesizer to generate the sounds that you hear when the Notelist plays. 
While a Notelist may have notes from any of the three Stereo-Mix Channels (left, right, center), the visual interface will only show 
and play the notes of one Stereo-Mix Channel at a time. The current Stereo-Mix Channel setting can be chosen from the View Menu 
(Display Center, Display Left, Display Right). PitchScope's various Audition Modes can allow the Notelist to be played by itself, or 
along with the source Wave Recording. And other PitchScope mechanisms allow individual Notes of the Notelist to be heard and 
audibly tested. Also read the Ways of Listening to Wave Recordings and Notelists section. And also see Notelist File, Note, SW 
Synthesizer, Stereo-Mix Channel, Wave Recording and Audition Mode in this glossary.   
  
Notelist File - The current Notelist may be saved to hard disk as a PitchScope Notelist File, and will have the ".pnl" file extension 
(Pitch NoteList). Saved Notelist Files may be re-loaded to PitchScope for user practice sessions, as the user plays along with a 
Notelist. A Notelist and the Project File that was used to create it, are forever 'linked' together. While an individual Project may 
spawn many different Notelists, each Notelist will always refer back to the Project File that it came from. While it is best that the user 
also loads the Project File that a Notelist was derived from, it is not necessary. The Notelist File only needs to be able to find the 
Wave File (.wav) that was its source. This way you can share Notelist Files with your friends who have purchased PitchScope, as 
long as you also give them the source Wave File as well. If a Notelist cannot find the source Wave File, the Notelist will only be able 
to play the through the midi SW Synthesizer, and the Wave Recording will not be heard. Also see Project File and Wave File in this 
glossary.  
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Notelist-Only Separation - Besides being able to listen to the source WAV file that the Notelist was detected from, you can also 
create two types of Separation WAV files that can be listened via a setting on the Audition Menu. The Notelist-Only Separation WAV 
file is made from the ReSynthesis menu, and is a modified WAV file that has only the sounds and tones of the notes in the Notelist. 
Also see  Create Notelist-Only Separation menu command and the Audition Menu's Notelist-Only Separation menu command. 
 
Octave - An octave is a musical interval comprised of 12 half-steps. A half-step is the musical interval between two neighboring 
keys on a piano. So, on a piano we identify the various octaves by a repeating visual pattern of 12 half-steps, which are 5 black keys 
and 7 white keys (5+7= 12 half-steps). Two notes that have the same ScalePitch but are in neighboring octaves will almost sound 
alike, and will sound completely harmonious together. For example, two different notes that are both D#, but are in two neighboring, 
octaves will almost sound alike. PitchScope detects notes within a four octave range. Also see ScalePitch, Fundamental Pitch, and 
Note's Octave Handle in this glossary. 
 
Pause Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Pause Button.  
 
Pitch -  Every note has a given frequency that determines whether it sounds high, low, or somewhere in between. On a piano, the 
way you would play a note with a different pitch is to strike a different piano key. PitchScope detects the different pitches that occur 
during an instrument's solo in order to create the Notes for the Notelist. PitchScope refers to 2 different types of Pitches: 1) 
Fundamental Pitch and  2) ScalePitch. Also see Fundamental Pitch, ScalePitch, and Note in this glossary.   
 
Pitch Viewer Window - Go to this document's Window Diagrams section, Pitch Viewer Window sub-section, to see a picture of 
the Pitch Viewer Window. If a Pitch Viewer Window is not already displayed, you can open one from the View Menu by selecting 
"Pitch Viewer". After a Detection Zone has been created, you can see the pitch activity for each ScalePitch Channel drawn as 
clusters of white and light gray pixels upon the black Detection Zone. The Pitch Viewer Window supplies additional data to aid you 
during your cleanup evaluations after an initial note detection scan has been completed. Also read ScalePitch and ScalePitch 
Channel in this glossary. Step through Tutorial A: Doing a Simple Note Detection. 
 
Play Backwards Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play 
Backwards Button.  
 
Play Forward Button -  Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play 
Forward Button.  
 
Play Note Tool - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play Tool Button.  
 
Play Current Note Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play 
Current Note Button.  
 
Play Next Note Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play Next 
Note Button. 
 
Play Previous Note Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play 
Previous Note Button. 
 
Play Speed Buttons - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play Speed 
Buttons. 
 
Play Window Button (PW) - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Play 
Window Button. 
 
Polyphonic Recording - A polyphonic recording is one where there is more than one instrument playing at a time, as in a band. 
Pitch detection is simple if only one musical instrument is playing, but with a polyphonic recording of multiple instruments it becomes 
very, very difficult. PitchScope does pitch detection and note analysis on polyphonic recordings by only trying to detect the most 
dominant note of an instrumental solo at any given moment in time. For this reason, PitchScope's Notelists can NOT play more than 
one note at a time.   
 
Project - In PitchScope, pitch detection and musical transcription always start by first creating a Project. A transcription Project is 
forever linked to the source Wave(.wav) file that it was made from. Never try to rename a Project File, and never modify the source 
Wave(.wav) File after a Project has been created. The Project also stores the Detection Zones that you will create. Within a Project 
you may create and save any number of Notelists, but each Notelist can only refer back to its parent Project. If you want to see the 
Project's folder path for the source Wave File and its own path, go to the File Menu and select "Project Options...".  Also see Project 
File in this glossary, and Tutorial A: Doing a Simple Note Detection. 
    
Project File - The transcription Projects that you create in PitchScope can also be saved to hard disk. You can then reload a 
Project in order to create new Detection Zones, or to refine one of the Project's Notelists. A Project file will have the extension ".ppj" 
( Pitch ProJect ).  Never rename a Project file, and never delete its source Wave File (.wav). If you want to see the Project's folder 
paths for its source Wave File and its own path, go to the File Menu and select "Project Options...".  Also see Project in this 
glossary. 
  
Revolver Animation Window - This is one of many animation windows whose sole purpose to vividly display the current playing 
note, so that the user can practice along with the Wave Recording and/or Notelist at a slower speeds. It is nicknamed the 'Revolver' 
window because the 12 ScalePitches are displayed in a circular format. 
 
ScalePitch - Within PitchScope, pitch is presented in two different ways: 1) Fundamental Pitch, and 2) ScalePitch. In the Note 
Detector Window you see a Notelist's notes displayed by their Fundamental Pitch, that is in a range of many Octaves. Fundamental 
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Pitch contains an octave value, and is what you see when you look at notes in sheet music. However, ScalePitch only has 12 values 
(E, F, F#,G,G#,A,A#,B,C,C#,D,D#) because there is NO octave assignment. {Do, Re, Mi, Fa, So, La, Ti, Do} is another way to 
express ScalePitch because it also contains no octave assignment. When you look at the 12 horizontal ScalePitch Channels of the 
Pitch Viewer Window, you can see the same notes of the Notelist as in the Note Detector Window, but displayed without their 
octave values. Also see Fundamental Pitch, Octave, and ScalePitch Channel in this glossary. 
 
ScalePitch Channel - Go to this document's Window Diagrams section, Pitch Viewer Window sub-section, and look up 
ScalePitch Channel. 
 
Selection Tool - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Selection Tool 
Button.  
 
Step-Play Note Buttons - The three Step-Play Note Buttons (Play Previous Note Button, Play Current Note Button, Play Next 
Note Button) are located on the Toolbox (see document's Window Diagrams section, Toolbox Window sub-section). Use these 
buttons when you want to audibly test whether or not the note detector has picked the correct pitch and octave for a note. Here is 
how the buttons work. First, select a note with the Selection Tool to establish it as the 'current note'. Then, hit the Play Current Note 
Button, and PitchScope will play two successive tones: 1st) the Wave's recording's sound for the time span of the note, and then  
2nd)  the actual Note played through the midi SW Synthesizer. If you want to again hear those two tones, just hit the Play Current 
Note Button again. When the two tones sound the most alike, you have correctly set the values (Octave, ScalePitch, Duration) for 
the note. You can then move to the next note and perform the same tone test by hitting the Play Next Note Button. By repetitively 
hitting the Play Next Note Button you can incrementally step through all the new notes in a detected Notelist while checking for and 
correcting errors. If you want to navigate to an earlier note, just hit the Play Previous Note Button. See Play Previous Note Button, 
Play Current Note Button, and Play Next Note Button in this glossary. Also read the Cleaning Up Notelists section, and also step 
through Tutorial C: Editing Some Notes   
 
Stereo-Mix Channel -  The current Stereo-Mix Channel setting has three possible choices: left, right, and center. This setting is 
chosen from the View Menu: 1) Display Center (channel),  2) Display Left Stereo (channel), and Display Right Stereo (channel). 
Because PitchScope detects notes from a stereo Wave Recording, it can choose to focus and detect from:  1) just the left stereo 
channel (Display Left Stereo),  2) just the right stereo channel (Display Right Stereo), or  3) both the left and right channels 
combined together (Display Center). For most musical instrument solos, Display Center will be the best setting for detection 
because most solos are typically mixed ‘to the center’ (between left and right). However on some recordings, the instrument's solo 
may be very dominant in just the left or right stereo channel. In that case, you might want to experiment by creating your Detection 
Zones with either the Display Left Stereo or the Display Right Stereo setting, wherever the instrumental solo sounds the loudest. It is 
acceptable to have multiple Detection Zones in different Stereo-Mix Channels within the same Notelist and Project. The only catch is 
that when you play the Notelist, you will only see and hear the notes of the current Stereo-Mix Channel setting. The current Stereo-
Mix Channel setting is written in the title bar of a window (see document's Window Diagrams section, the Note Detector Window 
diagram). Also read Creating Detection Zones in the Detection Topics section to get a better idea how Stereo-Mix Channels affect 
note detection. And also read Display Center, Display Left Stereo, Display Right Stereo in the Menu Commands section of this 
document. 
 
SW Synthesizer -  The midi  'SW(SoftWare) Synthesizer'  comes with the Windows operating system and is what and is what 
creates the sounds for the notes of a playing Notelist. By double mouse-clicking on the Speaker (Volume) Control Icon in the 
Windows Taskbar (far bottom right of screen), you will launch the Volume Control(Mixer) dialog box (for Vista, also click on “Mixer”). 
In order to hear the SW Synthesizer play the Notelist, the "Mute" checkbox for "SW Synth" must be unchecked and its volume slider 
should probably be on maximum. And similarly, in order to hear the source Wave Recording play, the "Mute" checkbox for "Wave" 
must also be unchecked and its volume slider should probably be on maximum. Also see Midi, Notelist, and Midi/Wave Balance 
Slider in this glossary. 
   
Toolbox Window - The Toolbox Window is the small, non-sizing, window that is seen when the application first starts. It is made 
up of many buttons and controls to help you navigate through Wave Recording and Notelist operations. Go to this document's 
Window Diagrams section, Toolbox Window sub-section, to see a picture of the Toolbox and its labeled buttons. The functions of 
the of the Toolbox's individual buttons are summarized in this glossary by the button names in the diagram. 
 
Transcription - When musicians listen to a musical recording and then write down its notes for sheet music, it is said that "they 
made a transcription of the song". While PitchScope can not write down notes in the notation style of sheet music, it can transcribe 
the notes into a Notelist and then display the Notelist in Piano Roll Format upon the Note Detector Window. Within this document, a 
'Project' is sometimes referred to as a 'Transcription Project'. Also see Project in this glossary. 
 
Transcription Project -  Within PitchScope, a Transcription Project is the same thing as a 'Project'. Also see Project and 
Transcription in this glossary. 
 
Time-Zone Selection - In order to create a Detection Zone or to detect some notes or to detect some notes within a Detection 
Zone, you must first create a Time-Zone Selection. This is created with the Selection Tool by pushing down the mouse's left button 
in the left part of the window, dragging the mouse (button still down) to the right, and then releasing the mouse button. After 
releasing the mouse button, the Time-Zone Selection Box should now be visible. The Time-Zone Selection Box will show an image 
in reversed gray colors and have two Handles (small hollow squares) at its borders. The Handles can also be horizontally mouse-
dragged to fine tune the borders of the Time-Zone Selection Box. If you are not happy with the position of the Time-Zone Selection 
Box, you can erase the Time-Zone Selection Box by mouse-clicking inside an empty area of the window, and then be free to create 
a new Time Zone Selection. See Selection Tool, Detection Zone, and Handle in this glossary. Also step through Tutorial A: Doing a 
Simple Note Detection. 
 
Time-Zone Selection Box -  The Time-Zone Selection Box is the graphical representation of a Time-Zone Selection. See Time-
Zone Selection in this glossary. 
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Vertical Scroll Knob -  A standard Windows control that is located at the very right of a window. If the window has been vertically 
zoomed-up (magnified), mouse-dragging vertically on the knob will scroll the window's image up or down. If the window has NOT 
been vertically zoomed-up (i.e. at its lowest vertical magnification), dragging this knob will have no effect. To bring a window to its 
lowest vertical magnification, repetitively hit the Vertical Zoom-Down Button until the window's image no longer shrinks in the vertical 
direction. When a new window is just opened, it is already at its lowest vertical magnification. See this document's Window 
Diagrams section, the Note Detector Window diagram.   
 
Vertical Zoom-Up Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up Vertical 
Zoom-Up Button.  
   
Vertical Zoom-Down Button - Go to this document's Window Diagrams section, Toolbox Window sub-section, and look up 
Vertical Zoom-Down Button.  
 
Wave File - This is the type of digital music file that is used on Audio CDs, and is also the preferred file format for PitchScope. 
".WAV" is the file extension for a Wave file. If possible, copy or 'rip' your song files to an uncompressed Stereo Wave(.wav) file 
format at 44.1 kHz with 16 bit samples. If you cannot extract your song files into that format, PitchScope can also use other Wave 
formats as well as the MP3 format, but PitchScope will have to first convert those formats and there may be a loss in sound quality. 
If a file conversion has been performed, only the .WAV converted version of the file is later needed. When you create a Project for 
transcription, PitchScope will prompt you for a Wave or MP3 File as its source. In order to hear the Wave Recording play once it is 
loaded to PitchScope, the "Mute" checkbox for "Wave" must be unchecked and its volume slider should probably be on full volume 
upon the Windows Speaker (Volume) Control dialogbox. Also, the Toolbox's Midi/Wave Balance Slider should be set in the middle 
position. The Windows Speaker (Volume) Control dialogbox is opened by double mouse-clicking on the Speaker (Volume) Icon in 
the Windows Taskbar at the far bottom right of the screen (for Vista, also click on “Mixer”). See Midi/Wave Balance Slider and CD 
Ripping Software in this glossary. Also see Working With Sound Files of the Basic Topics section in this document. And also read 
Tutorial B: Extract a Song from an Audio CD, and Convert a MP3 File to Wave Format. 
     
Wave Recording -  Virtually the same thing as a Wave File. Sometimes in this document we refer to a Wave File that has been 
loaded into PitchScope as a Wave Recording. 
 
.WAV File - The same thing as a Wave File.  ".wav" is just the file extension for a Wave File. See Wave File in this glossary.  
   
Wave's Time Ruler -  On the top of the Pitch Viewer Window and the Note Detector Window is the Wave's Time Ruler (see 
document's Window Diagrams section, the Note Detector Window diagram). It looks like a horizontal ruler with markings for the time 
position into the Wave file for that particular Wave image. The notation for the time markings are given in minutes, seconds, and 
milliseconds (example:  "2mn 43s 500ms" is 2 minutes, 43 seconds, 500 milliseconds).  Scrolling the window left or right with the 
Windows Horizontal Scroll Knob will change the time frame of the Wave file segment that is currently in view, and correspondingly 
change the numeric values on the Wave's Time Ruler. The Wave's Time Ruler will become useful when you attempt to find the 
beginning and end time boundaries of the musical instrument solo.  
 
Weak-Note Cutoff Slider - This is one of two slider controls on the Detect Notes dialog box, which appears after selecting the 
Detect Notes menu command. The Weak-Note Cutoff slider can be used to eliminate notes with a low detection value (Noise-
Notes), as shown by their dark gray color in the Note Detector Window. This control is the most useful in eliminating noise-notes 
during a detection scan. A high setting will eliminate too many valid notes, and a low setting will not eliminate enough weak 
erroneous notes. Users will want to experiment during a note detection scan to find the best setting that includes the valid notes, 
and only allows a small amount of noise-notes. After a note detection scan, users can manually delete the noise-notes with the 
Selection Tool and Edit menu commands. 
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